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INTRODUCTION 

The purpose of this manual is to provide with guidelines in using and managing VERSUS features. VERSUS 

is a GUI based software which loads observation and model data and performs various types of Verifications 

SOFTWARE REQUIREMENTS 

For information about software requirements see VERSUS - Technical Manual and SW Installation Step-by-

step 

INSTALLATION 

For information about installation see VERSUS - Technical Manual and SW Installation Step-by-step 

WEB GUI 

VERSUS is a system with a web GUI dynamically created with PHP code. 

In order to better utilize all system features, JavaScript has to be enabled on your browser. Please follow the 

instructions below for JavaScript activation on your computer. 

Internet Explorer 5.0 and above 

1. Go to Tools > Internet Options > click on the Security tab  

2. Click on the Custom Level button and scroll towards the bottom of the list  

3. Make sure Active Scripting is enabled  

4. Save the settings and refresh the page  

Mozilla Firefox 1.0 and above 

1. Go to Tools > Options > click on the Content tab  

2. Check the box, Enable JavaScript  

3. Save the settings and refresh the page  

4. It is necessary to enable pop-ups from VERSUS address. 

Firefox 

Go to the Edit->Preferences menu and select the Content icon at the top of the dialog. If "Block pop-up 

windows" is checked, add www.nanohub.org to the Exceptions list. 

Firefox also uses plug-in to filter pop-ups. The most common plug-in is NoScript. To enable pop-up for a 

particular page, select the highlighted "S" icon at the bottom of the browser to guideNoScript to allow the pop-

up.  

InternetExplorer 

Go to Tools->Internet Options menu. Click on the Privacy tab. Uncheck the field 'Block pop-ups' ('Turn on 

Pop-up Blocker' in IE 7.x). This will unblock pop-ups from all sites. To only allow pop-ups from nanoHUB, 

check 'Block pop-ups' and click on Settings. Enter nanohub.org in the field 'Address of Web site to allow:' and 

click Add. Close all windows.  

The GUI is optimized for 1280x1024 resolution with last versions of Internet Explorer (7.x) and Mozilla Firefox 

(3.x). 

Note.To change zoom with Firefox Mozilla 3 and to maintain an optimized GUI it is necessary to control that 

menu ‘View  Zoom Zoom Text Only’ is not selected. 
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It is not recommended to change zoom with Internet Explorer because in some cases this browser does  

not ensure an optimized resolution for text modified using CSS. 

Figure 1 VERSUS Home page 

On the left shoulder on VERSUS home page there are useful links to User Manual, Technical Manual and Version 

information.  

In the Version link the following information is shown: 

Version Number: VERSUS Version installed 

Release Date: Official Date release 

Installation Date: Installation date on the machine 
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Figure 2  VERSUS Version information 

Once logged into VERSUS system by user name and password, the system displays the following message: 

 

Figure 3 VERSUS login (Administrator) 
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Figure 4  VERSUS login (Consultant) 

MENU 

Once logged, the right shoulder shows VERSUS Navigation Menu. The following sections are displayed: 

Administration: the general administration management of the system, reserved to the Administrator user  

Configuration: the general system registry configuration, reserved to Administrator and Operator 

Verification: option for Verification configuration, reserved to Administrator and Operator 

Report: Results and data analysis reports, available to all users. 

Versus manages three types of users:  

Administrator user can manage data acquisition and Front End loaders, errors, users, numerical and 
graphical scores. He has the highest level of user privileges. 

Operator user is able to create scores on the database loaded into VERSUS DB, look at  the results, perform 
the appropriate  re-run of the scores, and eventually delete them. He has the medium level of privileges. 

Consultant user can only look at the score results. He has the lowest level of privileges. 

This table displays the different users privileges 

MENU ADMINISTRATOR OPERATOR CONSULTANT 

Administration X   

Verification X X  

Configuration X X  

Report X X X1
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4.1 ADMINISTRATION MENU 

Currently, the system has only one administrator user with: User name: versus- Password: versus (the 

password is versus) 

Figure 5. Administration Menu 

 

By clicking on “Administration” option, the system displays the sub-menus User and Process. Administrator 

user can manage both of them.  

. 
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4.1.1 USER ADMINISTRATION 

By clicking on User sub-menu the system displays the following: 

Figure 6 User Menu 

The Administrator can create  new users by clicking on “Registration”  option of the “User” menu (Fig. 5): 

Figure 7 User Registration 

The new users can login using the user id with the following syntax: name.surname.  

The Administrator: 
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 can change a user’s name,  surname and  password; 

 cannot change the user role 

 can delete one or more users 

When a user wants to leave the system, he must click on link Logout, so the session will be reset. 

Administrator user can modify a user by clicking on “Modify” option of the “User” menu: 

Figure 8 User Modify 

Administrator user can delete a user by clicking on “Delete”  option of the “User ” menu: 

Figure 9 User Delete 
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4.1.2 PROCESS ADMINISTRATION 

There are five main  procedures in the menu Administration->Process: 

 

 

 

 

 

 

 

 

 

 Acquisition Manager. This FE manages data loading into database, surface observations, upper (BUFR 

or ASCII format), feedback files data in netcdf format (TEMP from radiosonde and AIREP from aircraft  

including AIREP report, AMDAR and ACARS.)  and forecasts (GRIB format).  Only the Administrator can 

create a new Front End through the Web GUI. 

 

 Acquisition Registration Administrator can create new FE (Front Ends) 

 Scores Manager. This FE manages the production of numerical and graphical scores. The front-end 

scores are previously configured into the system and users are not allowed to create new  ones. 

 Batch Execution  This procedure allows monitoring of the status of  periodical verifications (Monthly or 

Seasonal)  and running a set of verifications. 

 Queue Manager  This procedure checks the verifications that are running, to be executed (pending) or in 

error. The icon  will be present in case there are verifications in queue in any of the possible  

states 

 

4.1.2.1 ACQUISITION MANAGER 

Clicking on “Process” menu item, the system displays the FE loader monitoring form: 

 

Figure 10 Administration ->Process  
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Figure 11 Monitoring loader FE 

In the above GUI,  the following information for each loading Front-End (FE) is displayed: 

Name: the unique name of the FE 

Process: the status of the process that can be either ‘Stopped’ or ‘Started’ 

Status: the status of the FE that can be either ‘Online’ or ‘Stand-by ’.An FE is Online when it is ready to ingest 

data. Ingestion is possible when the Acquisition Manager is in START mode. 

Acq. Files: the number of files that are ready to be acquired  

Error Files: the number of files that have been rejected from the system 

Backup Files: the number of backup files 

       Report: the link to the FE report 

Modify: the link to FE modification Form 

Logs: the link to the list of log files (files with information on the execution) related to the FE 

Delete: Delete  a FE from the VERSUS DB 

Loader FE  To start it up through the WEB GUI, the user should click on Start Button. Alternatively, he can 

run the script ‘/home/versus/VERSUS/sviluppo/classes/loader.php’ from VERSUS server To stop it through 

the WEB GUI, user should click on Stop button. 

It is also possible to start up the FE by command line editing in the file:  

VERSUS_HOME/sviluppo/classes/phpversusFE.php. This way of starting-up the acquisition process is highly  

recommended when the system has problems on ingestion phase.  

By clicking on  icon of the “Acquisition Manager” form, the system opens the GUI that displays the report 

of the related FE: 
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Figure 12 Process Report 

The displayed information is the following: 

Name: the FE name 

Msg Name: the type of data that the FE manages (for example, grib, bufr) 

Description: the FE description 

Stratification: the related stratification 

Parameter Correction: if the FE parameter correction is active or not 

Methods: the list of interpolation methods that the FE manages. 

Status Process: if the FE is in stand-by or online 

Log File: the path and name of the log file with the process information 

Error directory: the directory where the FE moves the error files 

Backup directory: the directory where acquired files are backed-up 

Input directory: the directory where files to ingest are copied 
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By Clicking on  icon of the “Acquisition Manager” form, the system opens the GUI for FE modification: 

 

Figure 13 Process Modify 

The information that can be modified for each FE is: Parameter Correction (Active or not), Description, 

Stratification, Methods, Status, Log File, Error directory, Backup directory, Input Directory. 

 

By Clicking on  icon of the “Acquisition Manager” menu or on “Log Manager” menu, the system opens the 

GUI that displays  the list of LOG Files of the FEs sorted by date. 
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Figure 14 Log Monitor 

 

Administrator can download the selected log files and look at them. When the Acquisition Manager is in  

START MODE, VERSUS creates a log file for each day The log file contains the eventual errors. The obsolete 

log files can be deleted from the system. 

 

4.1.2.2 Front-End ACQUISITION REGISTRATION 

Only the Administrator can create an acquisition Front End (FE), by clicking on “Acquisition registration” option 

of  the “Process Administration” menu. 
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Figure 15 Acquisition Registration 

To Register a new loader FE, the following information is needed : 

Name: the unique name of the FE 

Msg: the type of loaded data. It is ‘grib’ for model data,’bufr_synop’ for synop data in bufr format, ‘bufr_temp’ 

for temp data in bufr format,‘ synop’  for synop data in ASCII format, ‘temp’ for temp data in ASCII format, 

‘solar_obs’ for solar radiation data in ASCII format, ‘xml’ for XML files (see Apprendix II for xml format),  

‘feedbackfile temp‘ for FF TEMP,  feedbackfile airep’ for FF AIREP (netcdf) and ‘area_grib’ for grib data  when 

verification is based on analysis data. The FE area_grib data do not need stratification and method 

specification because they are ingested in gridded format..  

Parameter Correction: If parameter correction is active or not, (when Msg is grib)  

Description: meaningful description 

Stratification: the stratification the FE has to deal with. It is not specified in area_grib FE message type. 

Methods: the list of FE grib data methods for model value interpolation at the observation point. 

Status: if the FE is in stand-by or online  
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Log File: the log directory where log files are written 

Error directory: the directory where the FE moves the error files  

Backup directory: the directory where acquired files are backed-up 

Input directory: the directory where files to ingest are copied 

 
To load an ASCII text SYNOP observation file  the following format is needed where the fields are tab 

separated: 

1.id_station: the id that VERSUS provides 

2.dt_validity : in the format yyyy-mm-dd 

3.Step 

4.Ceiling 

5.Visibility 

6. total cloud 

7.wind direction 

8.wind speed 

9.T2m 

10.Td 

11.Mslp 

12. pressure tendency 

13.pressure change 

14. Precipitation 

15. precipitation type (1 if 13021 2 if 13022) 

EXAMPLE: 

20286 2010-01-01 00 24 5 5 180 5 5 5 1000 1 1 10 1 
20286 2010-01-01 03 24 5 5 180 5 5 5 1000 1 1 10 1 
20286 2010-01-01 06 24 5 5 180 5 5 5 1000 1 1 10 1 
20286 2010-01-01 09 24 5 5 180 5 5 5 1000 1 1 10 1 

 

Note that VERSUS does not create accumulation precipitation values from hourly data, so the data 

should be preprocessed before being loaded. 

 

Ingested grib data are coded with different TRI (Time Range Indicators) depending on the value that is 

represented each time. According to WMO the TRI values are defined as follows: 

0 Forecast product valid at reference time + P1 P1>0), or Uninitialized analysis product for reference time 

(P1=0). Or Image product for reference time (P1=0) 

1 Initialized analysis product for reference time (P1=0). 
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2 Product with a valid time ranging between reference time + P1 and reference time + P2 

3 Average(reference time + P1 to reference time + P2) 

4 Accumulation (reference time + P1 to reference time + P2). Product considered valid at reference time + 

P2 

5 Difference(reference time + P2 minus reference time + P1) product considered valid at reference time + 

P2 

To load Feedback files : Two feedback files acquisition FE types can be created. The data types that 

VERSUS can ingest are the following: 

 - TEMP from radiosonde  

 - AIREP from aircraft  including AIREP report, AMDAR and ACARS. 

The GUI that manages the FE for FF TEMP ingestion is provided by clicking on “Administration->Process-

>Acquisition Registration” and choosing the “feedbackfile temp” in Msg option menu 

Figure 16 FE Acquisition Registration for TEMP Feedback files 

 
For TEMP FE, the main difference from other FE is the possibility to select the “State of Observation”.  

The stratification for TEMP FE can be a group of stations, similarly to other types. 
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  “State of observation” is an attribute that can also be selected in the verification configuration phase. 
Nevertheless it is preferable to make the data discrimination at this point of the loading phase , in order to avoid 
ingestion of  useless for verifications data that will impact the DB size.   
   
Similarly to TEMP data GUI that manages the FE for FF AIREP ingestion is provided by clicking 
on:“Administration->Process->Acquisition Registration” and choosing the “feedbackfile airep” in Msg option 
menu: The option ‘State of Observation’ is also provided 

 
Note !! The stratifications that are possible to select for FF AIREP  are registered as  “ Area Feedbackfile type  
“(defined by only area boundaries  in terms of lat1/lon1 and lat2/lon2 (see Stratification Configuration Chapter for 
details)  

 

The FE registration for XML files is similar. The XML input files observation and model structure is described in 

Apprendix II. The corresponding model type, mentioned in the XML file, should be registered as well, (See Model 

Registration)  before trying to ingest the files. 

 

The general procedure for input files ingestion is that they should  be put under the "input" directory, defined in the 

corresponding FE, for while the ingestion process is stopped. Then the "Start" button should be pressed, to start 

the ingestion process. The file(s) will then move to the "error" subdirectory, from which they will be read by the 

system. On a successful ingestion, each file is moved to "backup" subdirectory of the corresponding FE; on error 

in processing, the file will remain in the "error" subdirectory. The corresponding log file will be generated. 

 

4.1.2.3 SCORE MANAGER 

By clicking on “Score Manager” option of the “Process” menu, the system displays the following GUI for score 

management. 

Figure 17 Score manager 

 

Currently, VERSUS has the following score processes: 
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FE_ANALYSIS_SCORE: Process for computing analysis scores  

FE_CND_DIC_SCORE: Process for dichotomous scores on surface data for conditional verifications 

FE_CND_SRF_SCORE: Process for continuous scores on surface data for conditional verifications 

FE_EPS : Process for probabilistic scores on surface data for standard Ensemble Prediction System (EPS) 

FE_PREC_SCORE: Process for dichotomous scores on surface data for standard verifications 

FE_FF: Process for continuous scores on Feedback Files data for standard verifications. 

FE_SURFACE_SCORE: Process for continuous scores on surface data for standard verifications 

FE_UPPERAIR_SCORE: Process for continuous scores on upper air data for standard verifications 

 

By clicking on  icon of the “Score Manager” form, the system opens the GUI that displays the report of the 

related FE. 

 

Figure 18 Process Report 

 

By clicking on  icon of the “Score Manager” form, the system opens the GUI that displays the form for FE 

modifying. It indicates the directories and the names of the log files and the R code files for scores calculations. 
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Figure 19 Process Modify 

 

By clicking on  icon of the “Score Manager” menu, the system opens the GUI that displays the list of LOG 

Files, produced by the  FE sorted by date. 

 

 

4.1.2.4 BATCH EXECUTION 

By clicking on “Batch Execution” option of the “Process” menu, the system displays  the GUI for Verification 

Periodical Monitoring selection. (It is recommended that user should read the Verification Menu first) 

 

 

Figure 20 Batch Execution Selection 

 

User can select Score Periodical Batch Execution or Cross Periodical Batch Execution. 
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The Score Periodical Batch Execution  GUI allows definition of the verification process which can be  

Monthly or Seasonal, and gives the possibility of running sets of verifications. 

Figure 21 Score periodical Batch Execution 

 

The Score periodical Batch Execution form includes two sections.  

The first section defines the  verification parameters , and  the following information is needed: 

Model Process: the model process  to be verified  

Type: Monthly or Seasonal 

Year: the verification year  

Month or Season: if the Type field is set to “Monthly” the system displays  the list of months. If the  Type field 

is set to “Seasonal” the system displays  the list of seasons DJF, MAM, JJA, SON. 

By Clicking on  “Search” the system displays  in the second section, the status of verifications for execution  

giving the capability to run them, either separately  or  together. 

The verification information section  includes the following:  
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Verification Type: this field displays  the number of available verification types  (monthly or seasonal) grouped 

for “Continuous standard criteria for surface data, Continuous standard criteria for upper air data, 

Dichotomous standard criteria, Continuous conditional criteria for surface data, Dichotomous conditional 

criteria for surface data, Time series, Daily cycle, Scatter plot, surface continuous EPS, surface dichotomous 

EPS,  Standard Surface Analysis, Standard upper air Analysis”.  

Status: It displays the  number of verifications that have already been executed. 

Execute: It allows execution  of pending only verifications per block  

Force Execution: It forces execution of all  verifications per block   

Finally the button “Execute All”  tells the system to execute all the pending verifications in the GUI and  the 

button “ Force execute All” forces execution of all verifications. 

The system also allows execution of individual selected verifications. By clicking on Verification Type link the 

system displays  a form listing the configured criteria of each block. As an example for Surface Monthly  

Verifications the following report is displayed: 

 

Figure 22 Batch Execution  

 

The Batch execution Report displays: 

 Id: the id of verification , which  is a link to the criteria report 

 Name: the description of the verification 

 Run: the configured run 

 Execution: if the verification has been executed or not 

 Stratification: the related stratification  

User can now select the Verifications to be executed by ticking the box of each one or select all of them by 

clicking on “Select All” button. By clicking on ‘Run” button only the pending verifications will be executed, while 

by clicking the Button “Force Run”  all the verifications  will  be executed anyway. 

By running a verification in batch mode the plot of the verification is also executed, with the condition that the 

plot has already been configured and executed at least once. 
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By running verification from the VERSUS Batch Execution functionality, the GUI is automatically redirected 

to the Queue Manager (see chapter) where all the selected process are listed with description of their state. 

 

 

Figure 23 Queue Manager (Redirected from Batch Execution) 

 

The Cross periodical Batch Execution GUI allows execution of cross model verifications.  

 

Figure 24 Cross Periodical Batch Execution 

The Cross periodical Batch Execution form includes two sections  

The first section defines the verification parameters and the following information is needed: 
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Type: Monthly or Seasonal 

Year: the verification year  

Month or Season: if the Type field is set to “Monthly” the system displays  the list of months. If the  Type field 

is set to “Seasonal” the system displays  the list of seasons DJF, MAM, JJA, SON. 

By Clicking on  “Search” the system displays  in the second section, the status of verifications for execution  

giving the capability to run them, either separately  or  together 

The verification information section  includes the following:  

Verification Type: this field displays  the number of available verification types  (monthly or seasonal) grouped 

for Cross model continuous standard/conditional/weather type criteria for surface data ,Cross model 

continuous standard criteria for upper air data, Cross model dichotomous standard/conditional/weather type 

criteria for surface data, Cross model dichotomous standard criteria for upper air data, 

Status: It displays the number of verifications that have already been executed. 

Execute: It allows execution of pending only verifications per block  

Force Execution: It forces execution of all  verifications per block   

It is also possible to execute individual selected verifications by the same procedure already mentioned for 

Score periodical Batch Execution. 

All the scores executed by this GUI have log filenames as follows: 

 

Figure 25 Cross periodical Batch Execution Selection 

 

log_file_name.txt_yyyy-dd-CurrentMonth-ID_SCORE_ScoreMonth for monthly 

or 

log_file_name.txt_yyyy-dd-CurrentMonth-ID_SCORE_ScoreSeason for seasonal 

By clicking on Score Manager->FE_SURFACE_SCORE the system displays: 
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Figure 26 Log Monitor 

The log files can be downloaded. 

4.1.2.5  QUEUE MANAGER 

By clicking on “Queue Manager” option of the “Process” menu, the system displays a  GUI   In order to get in real 

time information about the state of active or ended process, The Queue Manager page shows a summary of the 
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currently VERSUS active processes. In the following examples are reported Queue Manager information in case 

of ‘Running’, ‘To be executed’ and ‘Error’ processes. 

 

Figure 27  Queue Manager Example 1  

 Figure 28 Queue Manager Example 2 

The page includes a table described hereafter : 

 

  

Description Text description of verification (link ) 

Date starting date and ending date 

PID  System process identifier 

Time execution Time in seconds from the start of execution  

File log Access to log file 

These features give the possibility to:  

 
- Check the scores activated and their state ( Error,  Running or waiting for execution) 
- Clear the error queue  
- Stop active processes  
- Download the log file for each verification  

 

 Select All-> Select all processes  

 Dequeue -> remove process from  queue 

 Refresh -> force the page refresh (the page is automatically reloaded every 30 seconds ) 

 Back ->   back to the previous page 

This page is also partially accessible to consultant/operator users, only as a report of processes. In this case the 

actions of select and dequeue are disabled.   
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Figure 29  Queue Manager for Consultants 

 

Figure 30 Queue Manager Warning Message 

 

Redirection to the Queue Manager is performed in the following cases: 

 If the system has already reached the maximum number of possible DB connections the execution of a 

new verification is inhibited. The page is redirected to the Queue Manager with a  Warning message  

Note: It must be noted that for EPS verification execution, at the moment it is not possible to run additional scores 

simultaneously in order not to overcome the maximum number of DB available connections (defined in the my.cnf 

and currently fixed to 100).  

This value must be tuned based on the results of a test phase and of the current hardware features.      
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 If a user tries to run a verification already running for the same period, the system redirects to the Queue 

Manager with a warning message and the verification execution will not restart.  

Figure 31 Warning for already Running verification 

 

For each verification running a unique log file  is created  (stored in the directory $VERSUS_HOME/log). The file 

is not overwritten if a new verification is launched except for the case of ID and verification period being the same.  

The first part of  log filename is associated to the type of score based on the rules already defined for VERSUS 

and described in the technical documentation.  At the end of the string is appended ID  and start - end date of the 

current verification,  as shown in the example below. 

 

log_surface_score.txt_2015-3-Mar_4272_20130901-20130930 

 

 

 

 

4.2 CONFIGURATION MENU 

This menu  allows configuration of the system procedures features.  By clicking on configuration menu the 

system displays : 

Reference to the type  of 

score 

date of 

execution 
Start date – end date 

of verification 

period 
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Figure 32 Configuration menu  

The features that can be set are:   

WEATHER TYPE 

STRATIFICATION  

STATION 

INDEX 

RUN 

BUFR MAPPING 

PARAMETER  

FORECAST METHOD 

FORECAST MODEL  

SUSPECT OBSERVATION  

GEOGRAPHIC MAP 

FF MODEL SOURCE 

4.2.1 WEATHER TYPE (DEPENDENT) 

It is the  system section  for  setting weather type dependent features. 

4.2.1.1 WDT REGISTRATION 

By clicking on Weather type option  the system  displays the following form: 
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Figure 33 WTD Registration 

 

At this point it is possible to upload a Weather type file for a specific Weather Service location (WTD) by 

means of browse button, locate it the local directory and click on ‘load file’ 

 

A WDT file should  be  a txt file written  in the following way: The first part is the Weather Class description, 

written as follows: 

1 Zonal cyclonic ZN 

2 Zonal anticyclonic ZA 

3 N-NW cyclonic NNWC 

4  N-NW anticyclonic NNWA 

etc. 

The first field is the class number, the second field the class description and the third field an abbreviation. 

The fields must be separated by tab and each class must be defined on a single line. 

The second part is the Weather Class description for each date. The word “Start” indicates the point where 

the date description starts . For example: 

1 Zonal cyclonic ZN 

2 Zonal anticyclonic ZA 

3 N-NW cyclonic NNWC 

4  N-NW anticyclonic NNWA 

Start 

2010-01-01  1 
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2010-01-02  2 

2010-01-03  1 

etc. 

The date and related class definition number, separated by tab are required.. The date must  be given  yyyy-

dd-mm format. When the WDT file is ready the system can be acquire it into its DB by clicking on ‘load file’ 

button: 

Figure 34 WTD Report 

 

The system then displays a page  with the information of the created WTD file . 
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4.2.1.2 WDT APPEND 

It is also possible to edit   an existing WTD file and  add new   dates by inserting  data in the following way: 

Start 

2010-02-01  1 

2010-02-02  2 

2010-02-03  1 

The system will append the  new dates  in the WTD file. 

 

 

By clicking on Weather Type->Append option  (right menu) , the system displays: 

Figure 35 WTD Append/Modify 

 

The list of reports for each Weather Service location is displayed. By clicking on icon “Report” the system 

displays the information of each  WTD. By clicking on icon “Modify” the system displays a form where  user 

can modify class description and add/edit an abbreviation for each one. 
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Figure 36 WTD Modify 

By clicking on  “Append” and then on ‘Browse’ the system displays: 

Figure 37 WTD Append 

The user can append further date classification on existing Weather Service by adding a txt file  
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4.2.1.3 WDT DELETE 

It is also possible to delete to an existing WDT, by clicking on Weather Type->Delete, and the system displays: 

Figure 38 WDT Delete 

The system shows all the existing WDT  and user can select  the ones to be deleted. 

 

 

4.2.2 STRATIFICATION 

The stratification menu is the part of the system that manages stratifications. A stratification groups a set of 

stations. User can create a new stratification, modify or delete it. To create a stratification, user should click 

on ‘Registration’ of the Stratification menu, specify the stratification name and select the stations 

 

4.2.2.1 STRATIFICATION REGISTRATION 

To select the stations of  a new  stratification, two methods are  possible. By Country or by Area. 

To select the stations by country user must select ‘Country’ on the ‘ Stratification type’ menu and select one 

of the available countries.  
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Figure 39 Stratification Registration by Country 

 

The altitude limits of the stations  is possible by entering a minimum and maximum height on “ Quota (meters) 

from/to”.  (If  *  is left, no height selection is performed)  

Description:  A name of the stratification 

By clicking on Search, the available stations are displayed on the left window, and user can add/remove 

selected stations on the right window with the arrows. 

The new stratification is saved by clicking on ‘Save’. 
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To select the stations by Area user must select ‘ Area’ on the Stratification Type’ menu and specify the latitude 

and longitudes of the lower left point of the area (LAT P1/LON P1) and the upper right one (LAT P2/LON P2). 

The next steps are the same as for the previously described country selection method. 

 

Figure 40 Stratification Registration by Area 

 

For FF AIREP data  the stratification is NOT  connected to a  list of fixed on-site points related to  meteorological 

stations or buoys, but the observations are intercepted at different, longitude, latitude and pressure levels 

encountered along the route. So, FF stratification is an extended area that includes all the data along the route.   

So, for AIREP data, the “Stratification type” option is “Area Feedbackfile”, with specification of lat/lon parameters.  

 

Figure 41 FF Stratification Registration 
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By clicking on ‘Save’, the registered stratification report is displayed 

 

Figure 42 FF Stratification Report 

 

 

4.2.2.2 STRATIFICATION MODIFY 

On  “Stratification” menu the option ‘Modify’ leads to GUI which allows stratification modification . 

 

Figure 43 Stratification Selection and Modification 
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The form displays  the stratification description, An icon linking to the related report, and an icon allowing 

stratification modification. The report icon displays  the following GUI : 

 

Figure 44 Stratification report 

The modification icon of Fig. 43 displays  the following GUI :  
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Figure 45 Stratification Modify 

 

To create a stratification with stations of two different countries, user must first create a stratification by 

selecting stations of the first country and save it with a specific name. Then by locating  its name on the 

stratification list and clicking on “Modify”, stations from a second country can be added. 

 



 VERSUS Page 49 of 235 

 

 

versus@meteoam.it 

 

4.2.2.3 STRATIFICATION DELETION 

On  Stratification menu the Delete option displays the following form: 

Figure 46 Stratification Delete form 

 

 There are two methods of deleting a stratification: 

Delete: delete the stratification only if it is not linked to products such as: verification, graphs, scores  

Force Delete: delete the stratification and all related links 

For example, on selecting Stratification “Delete” and clicking on Delete, the system displays 
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Figure 47 Stratification Delete Error 

all configured products  related to the stratification and deletion is not performed.  

However, by clicking on “Force Delete” button, the stratification and all related products are deleted.  

 

4.2.3 STATION 

The station menu manages the  registry that contains information about WMO stations. User can add a new 

station, modify or delete it. Alternatively user can load an ASCII file formatted according to specific  

requirements. 

4.2.3.1 STATION REGISTRATION 

By clicking on Registration item of the Station menu, the system displays  the following GUI: 
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Figure 48 . Station Registration 

By Clicking on Registration option, the system displays  the GUI that allows insertion of a single Station into 

VERSUS DB. 

 

Figure 49 Single station registration 
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The parameters to specify on inserting a new station are: 

Station type: the type of the station e.g. DCP  

Description: a station description 

Block number: WMO block number code of the station 

Station number: WMO station number code of the station 

ICAO: the ICAO code 

Latitude: latitude of the station in geographical coordinates 

Longitude: longitude of the station in geographical coordinates 

Height: station elevation in meters 

For entering stations data written in an ASCII file,  the user should click on Browse of the Station Registration 

menu,  select the  file, with the stations information, and click on ‘Load stations’ option . 

When the file is loaded, assuming there are no errors,  all loaded stations information is displayed on a page 

for checking. 

The file format used is the MASTER FLAT FILE for WMO Publication No. 9 Volume A – Observing Stations. 

4.2.3.2 STATION MODIFY 

By clicking on Modify option  of the Station menu, the system displays  the following GUI (Fig. 81): 

Figure 50 Station Modify 

In the form above is possible to search for stations by filling in one or more  fields,  A list of stations is displayed 

with their information (missing figure). By clicking on ‘Modify’ icon user can make modifications on each 

station. 
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4.2.3.3 STATION DELETE 

By clicking on delete option  of the Station menu, the system displays  the following GUI: 

Figure 51 Station Searching for Delete 

 A search of stations is again performed by filling in the appropriate fields, and the system displays  the 

following GUI: 
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Figure 52 Station Delete 

 

Stations can be deleted by checking their names on the GUI above and clicking on Delete button.  

 

4.2.4 INDEX 

This part of the system manages the index scores definition. 

The index scores that Versus manages are continuous or dichotomous. Every index score contains its  

algorithm  written in R code.  

User can create a new index, modify or delete it. 

4.2.4.1 INDEX REGISTRATION 

By Clicking on option  registration of the “Index” menu, the system displays  the following GUI: 

 



 VERSUS Page 55 of 235 

 

 

versus@meteoam.it 

 

Figure 53 Index Registration 

 

The user has to specify: 

Index type:  continuous or dichotomous 

Score type: if the index is s skill score or not (is compared to persistence/climatology or not) 

Approach: Deterministic or probabilistic 

Description: a short description 

R/PhP Code Procedure: a piece of R code that will be executed from the system. Note that the variables 

that the system uses for continuous indexes are: 

fcs: to identify the forecast array 

obs: to identify the observation array 

persistence: to identify the persistence/climatology (reference) array of obs (for skill scores) 

wind_d: the forecast – observation array of the wind direction correctly adjusted  

u_d: the forecast -observation difference array of the u-component parameter 

v_d:the forecast -observation difference array of the v-component parameter 

persistence_u: array to identify the persistence/climatology (reference) of the u-component parameter  

persistence_v: array to identify the persistence/climatology (reference) of the v-component parameter 

The variables that the system uses for dichotomous indexes are A,B,C,D resulting from the  contingency  

tables. A is the number of hits, B is the number of false alarms, C is the number of misses and D the number 

of correct rejections.  

4.2.4.2 CONFIDENCE INTERVALS INDEX REGISTRATION 
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If user wants to calculate Confidence intervals for continuous scores (by bootstrap method, see Apprendix I 

for details) (note that ONLY EPS scores are automatically calculated) he needs to register CI High and CI low 

for each score via web GUI by writing code in the R/PhP window. The setup changes for different scores but 

the pattern is the following (for high CI): 

require(verification) 

booter <- function(d, i) { 

A<-verify(d[i, "surface_value"], d[i,"grib_value"],frcst.type="cont", obs.type="cont") 

return(c(A$MAE)) 

} 

df=data.frame(fcs,obs) 

booted <- boot(df, booter, 300);score_ci <- boot.ci(booted,conf=c(0.99),type=c("perc"),index=1) 

high_ci <- score_ci[[4]][5];index <- high_ci 

For low CI the last line should be replaced with  

  low_ci <- score_ci[[4]][4];index <- low_ci 

The confidence level can be changed by setting up conf option. Here, the most widely used percentile method 

is used (type=c(“perc”)) but several other options are available, e.g., BCa method (type=c(“bca”)). (also 

“norm”, ”basic”, ”stud”). Here 300 is the number of resamplings and 0.99 the confidence level. These values 

can  be changed by user. In Apprendix III there are code examples for all confidence indexes  

 An example of MAE CI Low registration is shown below. By clicking on “Configuration->Index->Registration”  

fields should be filled in  the R/PhP window: 

  Figure 54 Index CI registration 
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By clicking on ‘Save’, the following report is displayed and the CI_low index is available to be selected. 

Figure 55 MAE_CI Low Report 

 

To calculate Confidence intervals for most dichotomous scores (namely EDS, ETS, F, FAR, HSS, KSS, ORSS, 

PC, POD, and TS) (normal distribution see Apprendix I for details) registration of CI High and CI low for each score 

via web GUI by writing code in the R/PhP window. The setup changes for different scores but the pattern is the 

following  (eg. For ETS high): 

require(verification) 

obs <- c(a,b,c,d) 

A<- verify(obs, pred = NULL, frcst.type = "binary", obs.type = "binary") 

B=qnorm(1-0.01/2)# For 99% higher CI 

index <- A$ETS+B*A$ETS.se 

The user can easily change the confidence level by writing, e.g., qnorm(1-0.05/2) for higher 95% confidence level. 

Note that for the lower 95% CI, one should type qnorm(0.05/2), and for the lower 99% CI: qnorm(0.01/2). Note 

that FBI CI are calculated using bootstrap and PAG CI with Wilsons method. The codes for all scores CIs are 

given in Apprendix III. 
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4.2.4.3 INDEX MODIFY 

The system gives the possibilities to modify an existing  index. By Clicking on option  modify of the “Index” 

menu, the following GUI  is displayed: 

Figure 56 Index Search 

The user can select  the type of index to modify: Continuous or Dichotomous. By clicking on Modify icon the 

following GUI is displayed: 

 

Figure 57 Index Modify 
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4.2.4.4 INDEX DELETE 

By clicking on Index->Delete option the system displays the following GUI, where user can select indexes for 

deleting. 

Figure 58 Index Delete 

4.2.5 RUN 

The run section deals with the model run (initial time) used by the system. User can register a run or delete  

existing ones by selecting from the menu..  
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Figure 59  Model Run Registration 

 

 

Figure 60 Model Run Delete 
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4.2.6 BUFR MAPPING 

The BUFR mapping is the part of the system that handles BUFR observation data that are coded according 

to WMO rules, by keeping ECMWF rules . User can register  a new WMO BUFR coded  parameter, modify  

or delete  an existing one. 

 

4.2.6.1 BUFR MAPPING PARAMETER REGISTRATION 

By clicking on ‘Registration’ option of ’BUFR Mapping menu’, a new WMO BUFR coded parameter can be 

registered and the following information is needed: 

ECMWF code : Select the parameter with its ECMWF BUFR code. 

WMO code:  Input the WMO BUFR code of the parameter. 

Sensor height  and  Displacement.  By clicking on ‘Save’, the registration is saved. 

Figure 61 BUFR Mapping Parameter Registration 

 

 

 

 

4.2.6.2 BUFR MAPPING PARAMETER MODIFY 

By clicking on ‘ Modify  of the BUFR Mapping menu, a GUI with the ECMWF description, ECMWF code, 

WMO code, Sensor Height (expressed in metres) and Displacement (expressed in minutes) of all registered  

observation parameters is displayed. 
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Figure 62 BUFR Mapping Modify 

By clicking on’ Report’ icon on the right of each parameter, the information on each of them appears. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 63 BUFR Mapping Parameter Report 
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By clicking on ‘Modify’ icon  on the right of each parameter the relative coding information can be modified by 

inserting the WMO code, sensor height and displacement and clicking on ‘’Update”. 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 64 BUFR Mapping Parameter Modify 

WARNING: Versus version 5.1.6 manages the new BUFR format of the synop messages. In this type of format 

cumulated/averaged fields (as windgust over 3 hours for example) are defined by the “time period” descriptor, wich 

Versus compares with the “displacement” chosen for the relative observed parameter, in the bufr mapping section.  

If new BUFR synop messages are used as input for verifications: 

- in the case of parameter “windgust” assure that loaded grib files interval period is consistent with the 

corrispondent  observed period which it is necessary to verify (the system does not distinguish this forecast 

parameter according to the cumulation period but only to the grib code 187 and code table 201). The time interval 
parameter used to calculate the maximum windgust in the COSMO model is “hincmxt” (&RUNCTL namelist 
parameter in INPUT_ORG). 

- In the case of other cumulated/averaged parameters (as precipitation for example) it is mandatory to define the 

“displacement” field in the bufr mapping window, otherwise the observed values will not be loaded into the DB. 

- In the case of windspeed parameters (for example 011002 or 011012) the field “displacement” must be left empty, 

because it is not associated to any time period inside bufr files. 

If new BUFR temp messages ( usable from version 5.1.9) are used as input for verifications: 

- If inside the new bufr temp template are present descriptors already in use in the Versus machine and registered 

as “surface” parameters, it is necessary to configure a bufr-mapping corrispondence between the old and new bufr 

descriptors (for example, let’s assume that the “Temperature” field is, in the old temp template, associated to the 

descriptor 12001 and registered as “upperair”; that “Temperature” field is, in the new  temp template, associated 

to the descriptor 12101 and that this descriptor is already in use for the parameter “Temperature at 2m”, thus 

registered as “surface” parameter; the bufr-mapping will be configured using “wmo code” = 12101 – “ecmwf code” 

= 12001). 
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4.2.6.3 BUFR MAPPING  PARAMETER DELETE 

To delete a BUFR mapping parameter user must click the option ‘Delete’ from the BUFR Mapping menu and 

the following GUI is displayed.  

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 65 BUFR Mapping Parameter Delete 

User should then select the mapping parameter to be deleted by ticking on the appropriate boxes or clicking 

on ‘Select All’ to select all of them. They can be removed by clicking on the ‘Delete’ button.    

 

4.2.7 PARAMETER 

There are three types of parameters in the VERSUS DB: the observation parameters (OBS), the forecast 

parameters (FCS) and the Feedback files (FF) parameters. The identification of the observation parameters 

is based on the bufrtables code. The identification of the forecast parameters is based on field code tables 

and forecast parameters in grib standard code. Users can create a new parameter, modify or delete existing 

ones.  

4.2.7.1 REGISTER A NEW PARAMETER 

The registration of a new parameter is different for the two parameter types OBS and FCS. Therefore, in the 

subsequent sections, the two procedures  are described separately. 

1) Register an observation Parameter 

The VERSUS system loads all registered observation parameters in a given  bufr file using the bufr-decoder 

of ECMWF. The list of registered parameters can be checked by choosing “Parameter” -> “Modify” from the 

VERSUS menu and selecting as Parameter type “OBS”. In case the desired parameter is not in the list, the 

user needs to register the parameter via the web browser. 

By clicking on option  “registration” of the menu “Parameter” the system displays  the following GUI: 
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Figure 66 OBS Registration 

 

The information to be filled in is: 

OBS Type: select accumulation surface parameter, surface,  upper air, or wind direction type parameter 

Bufr Code: the BUFR code that can be found in BUFR TABLES 

Description: the parameter description usually found in BUFR TABLES 

Unit Input: bufr unit of the parameter 

Formula: a formula to apply for unit conversion, e.g. K is converted into °C. This field is written in php code.  

The formula must end with the character “;” 

Unit: parameter unit after formula application 

In case of no unit conversion, the formula field is left empty and the Unit is the same as the Unit Input. 

To finish this procedure, the parameter registration needs to be saved. In order to verify  whether the 

registration of the new parameter was successful, new parameter type  observation data should be uploaded 

for a test time period and then  data availability should  be verified  for the same time period. 

2) Register a forecast parameter 

The list of registered parameters can be checked by selecting  “Parameter” -> “Modify” from the VERSUS 

menu and selecting as Parameter type “FCS”. In case the parameter of interest is not in the list, it needs to 
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be registered. Unlike the registration of an observation parameter, it is not entirely web GUI based but requires 

first the extension of the configuration xml file located at HOME/VERSUS/conf/grib1.xml.  

Step 1: add new parameter in the file HOME/VERSUS/conf/grib1.xml 

The file has the following structure: 

<fields> 

<!-- LM --> 

 

To add a single field parameter (for example, Temperature) the code is the following: 

 
<field name="temp"> 

<element name="t" unit="°C"> 

<codeTable>69</codeTable> 

<parameter>11</parameter> 

</element> 

 

</field> 

To add a parameter composed by two fields (Wind with u and v coordinates), the code is: 

 

<field name="wind"> 

<element name="u" unit="m/s"> 

<codeTable>2</codeTable> 

<parameter>33</parameter> 

</element> 

<element name="v" unit="m/s"> 

<codeTable>2</codeTable> 

<parameter>34</parameter> 

</element> 

</field> 

The above is an example of wind field definition where the wind forecast parameter is given in u and v 

coordinates. The system automatically calculates wind speed and wind direction. However, in case the wind 

speed and wind direction are also included in the forecast data and need to be ingested in the DB, the code 

is the following: 

 
< 

<field name="wind"> 

<element name="u" unit="m/s"> 
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<codeTable>2</codeTable> 

<parameter>33</parameter> 

</element> 

<element name="v" unit="m/s"> 

<codeTable>2</codeTable> 

<parameter>34</parameter> 

</element> 

</field> 

<field name="wind_ff"> 

<element name="ff" unit="m/s"> 

<codeTable>2</codeTable> 

<parameter>32</parameter> 

</element> 

</field> 

<field name="wind_dd"> 

<element name="dd" unit="degree true"> 

<codeTable>2</codeTable> 

<parameter>31</parameter> 

</element> 

</field> 

 

So, for any new parameters, the related entry has to be added defining the field name, the element name, the 

unit, the code table and the parameter following the xml format.  

 

Step 2: upload a grib file containing the new parameter via the appropriate front end 

In  the updated grib1.xml file, the system is able to identify  it via the code table and the parameter identifier. 

Note that a new grib file needs to be ingested into the DB in order to put this new entry into the parameter list 

in the web GUI.  

Step 3: modify the description of the new parameter via the GUI 

When the system identifies a new forecast parameter (i.e. after a grib file with the new parameter has been 

uploaded), the entry “TBD” (To Be Defined) appears  in the description field indicating that a  description has 

to be defined. To do this, user should click on option “Modify” of the Parameter menu and select ‘FCS’ on the 

Parameter Type menu. The available forecast parameters are displayed  in the following GUI: 
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Figure 67 List of FCST Parameters to Modify 

By selecting  the parameters with the description and unit set to “to be defined” (TBD), and clicking on the 

modify icon,  the GUI displays: 

Figure 68 FCS Parameter Modify 
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In this example, the code table 128 and grib code 228 refer to  the precipitation parameter. So the user has 

to fill in the description and units of the parameter to replace “TBD”. The OBS reference option refers to the 

corresponding observation parameter. 

 For model data used for Analysis verification, the path of the configuration file is 

VERSUS_HOME/conf/grib1.xml     

 NOTE: There is no registration procedure for FF data The parameters that are automatically loaded 

from the FF files are : Geopotential, Relative Humidity, Upper air Temperature, u and v wind 

components. 

 

4.2.7.2 MODIFY A PARAMETER 

Registered parameters descriptions and units can be also modified (e.g. in case of typos or more suitable 

descriptions etc). This is possible both for observation and forecast parameters. 

 Modification of an observation parameter 

By clicking on item “Modify” of the Parameter menu and selecting ‘OBS’ on the Parameter Type menu the 

available  observation parameters are displayed  on the following GUI: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 69 OBS Parameter Modify 

The user may now modify: 
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Description: the parameter description 

Unit Input: parameter unit before conversion 

Bufr Code: bufr code parameter 

Formula: a unit conversion formula, e.g. in this case the K is  converted into °C. This field is written in php 

code. Make sure that the formula ends with the “;” character. 

Unit:  parameter unit after formula application 

 

 Modification of a forecast parameter 

User can modify by GUI the forecast descriptions and units but cannot perform unit conversions as for 

observation parameters. To do that, code needs to be added in the file HOME/VERSUS/conf/griboper.xml 

which is the file that deals with parameter calculations. 

For example: For Temperature conversion from K to °C, the following code has to be added in the file 

griboper.xml : 

 
<dfield name="tCelsius" operation ="gribConstantSum" unit="°C" missingValue="9999.90"> 

<coding> 

NEW CODE  

<gribTablesVersionNo>69</gribTablesVersionNo> 

<indicatorOfParameter>11</indicatorOfParameter> 

</coding> 

ORIGINAL CODE 

<elementname ="t" > 

<codeTable>2</codeTable> 

<parameter>11</parameter> 

</element> 

<constant name ="absZero">-273.16</constant> 

</dfield> 

It is also necessary to add the following code in grib1.xml in order to allow ingestion of the calculated 
temperature data. 

 
<field name="temp"> 

<element name="t" unit="°C"> 

NEW CODE  
<codeTable>69</codeTable> 

<parameter>11</parameter> 

</element> 
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</field> 

 Modification of a feedback file  parameter 

To modify an FF parameter, user must select “Modify” on the Parameter menu and selecting ‘FF’ on the Parameter 

Type menu. The available observation parameters are displayed  on the following GUI 

 

 

 

Figure 70 List of FF Parameters to modify 
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4.2.7.3 DELETE A PARAMETER 

Configured parameters can be removed from the VERSUS DB by clicking on option “Delete” in the Parameter 

menu: 

Figure 71 Parameter Delete 

After having selected the parameter type (forecast, observation or FF), the list of available parameters is 

displayed. By checking the ones the user wants to delete, and clicking on ‘delete’ on the bottom of the form, 

the parameters are deleted. However, the user should double-check that the parameter has been deleted by 

displaying again the parameter list. 

 

4.2.8 FORECAST METHOD (INTERPOLATION METHOD) 

The forecast method is the algorithm used to calculate by interpolation  a forecast value  at the observation 

location. User can create a new method, modify  or delete an existing one.  

 Currently the available methods are: 

1) Nearest point 3D optimized  

2) Nearest Point height optimized 

3) 4 Nearest Points Mean  

4) Mean of points with R=30 km  

5) Nearest point distance  

6) Mean of points Circle with R=15 km  

7) 4 Nearest Points height optimized  

8) 4 Nearest Points distance  

9) Method for wave model  
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Registration of a new forecast interpolation method is only possible by GUI only for the case of Mean of Points 

of a circle, where user can define a Radius value. To do so, user should click on’ Registration’ Option of the 

Forecast Method menu and add a description of the method, for example . 06) Mean of Points Circle R=15km, 

Algorithm= Mean Radius, and Parameter the value of the Radius of the circle (eg. 15) . For any other method 

user has to enter in the Phoenix Code.  

Figure 72 Forecast Method registration 

The “method for wave model” has the following principle of operation: for each observation point, in terms of 

latitude and longitude, the method searches for the 4 neighboring points in the grid (are taken into account 

only points over the sea, according to the land-sea fraction provided); the best point corresponds to the one 

with minimum spherical distance from the observation point. 

 

4.2.9 FORECAST MODEL 

The forecast model is the part of the system that deals with the meteorological models that VERSUS uses 

.User can register  a new model, modify  or delete the parameters of an existing one. 

4.2.9.1 MODEL REGISTRATION 

Model type: It is the model type which contains the topography information. 

By clicking on  “Registration” option of the Forecast Model menu and then on (…) on the right of ‘ Model Type’ 

line the system displays  a window where the Model Type Selection GUI appears: 
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Figure 73 Forecast Model Registration 

 

The user can select the type of model  via the Model type selection menu: 

The user should  click on “New” option of Model type selection panel to create a new one, in case  there is 

not a valid type model in the selection menu: 

Figure 74 Forecast Model type registration 
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For registration of a new Forecast Model Type the system needs the following data: 

Description: a description of the model type 

Topography File: the path+filename of the GRIB format topography file to be decoded. This file should contain 

the land sea mask  (FR_LAND) and geopotential heights.(FIS) in the same dimension/resolution as the grib 

files that will be loaded.  

Grib Coding: the user should specify if the grib format is standard or ECMWF one  (normally if the precipitation 

fields are coded as time range indicator 4, is standard, otherwise is the ECMWF one) 

Process code ID : is the process code of the forecast to decode 

ID Center: is the numeric code of the origin center of the forecast 

Description: a meaningful description of forecast model 

Feature: if the forecast is probabilistic or deterministic 

Number of FCS Ensemble:  the number of the included members for probabilistic forecasts  

 To load model data other than COSMO in VERSUS database, (with standard “grib codify”) the model 

grid should be in spherical coordinates (or spherical coordinates with rotated pole) and the next steps should 

be followed: 

a) Make a topography file with variables : 

            Code: Select all 

GP:sfc:kpds=6,1,0:anl:winds in grid direction:"Geopotential [m^2/s^2] 

LAND:sfc:kpds=81,1,0:anl:winds in grid direction:"Land cover (land=1;sea=0) 

[fraction] 

And place it with other topography files, it will be needed on step b. 

ONLY for WAVE models - it is necessary to include a land-sea fraction grib file, with the following codification: 

land = 0 ; sea = 1. 

b) Create new model type in VERSUS GUI (Configuration - Forecast Model - Registration - Model type 

selection - New). Set path to the new Topography File. 

c) Create Forecast Model with the new Model type using appropriate Process code and ID Center. 

After that data could be loaded as usual. For example, this command can be used to convert EPS data: 

centre=4,subCentre=98,setLocalDefinition=28,localDefinitionNumber=28,marsCla

ss=co,marsType=pf,marsStream=enfo,experimentVersionNumber=0009, 

perturbationNumber=$imem,numberOfForecastsInEnsemble=$NMEMS $FILEOUT 

$FILEOUT1 

For WRF model  registration (ECMWF codify) 

a)  Switch to WRF UPP postprocessing option: outputs gribs instead of NetCDF (standard WRF ARW post 

postprocessing outputs NetCDF files). 

b). Create orography file as usually. 

c). Transfer this file into lat-lon projection using сopygb utility (part of UPP) (code 0 in grib). 

http://www.meteoam.it/forum-meteoam/viewtopic.php?f=14&t=173&p=877
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d). Register a new model in VERSUS GUI as usually. To choose Grib codify ECMWF. To change the 

process number and centre number using grib_set command, as in the previous example. 

 

Figure 75 Example of WRF model registration 

 

4.2.9.2 MODEL MODIFY 

By clicking on item “Modify” of Forecast Model menu the system displays the following GUI: 
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Figure 76 Forecast Model Modify 

 

By clicking on ‘Search’ on the right of  the model type to modify, the system displays model type and model 

process information. By clicking on Report icon  the related data information is displayed. By clicking on Modify 
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icon of model type, it is possible to modify related information. For model type modification the system displays 

the following GUI: 

Figure 77 Model type Modify  

 

By clicking on Modify icon of Model Process menu, (Fig.58) it is possible to modify model process information. 

For model process modification the system displays  the following GUI: 

Figure 78 Deterministic Model Process Modify 

For probabilistic models the number of ensemble members should also be specified. 

Figure 79  Probabilistic Model Process Modify 
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By clicking on Grid icon of model process menu, it is possible  to modify grid data . For grid modification the 

system displays  the following GUI: 

Figure 80 Grid information 

 

The user can delete or modify the grid. By clicking on Modify icon, the system redirects to the following form: 
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Figure 81 Grid modify 

The grid fields that can be modified are: 

Latitude of the first point 

Longitude of the first point  

Latitude of the last point 

Longitude of the last point  

Ni number of grid points on x-direction 

Nj number of grid points on y-direction 

Di x-grid spacing (degrees) 

Dj y-grid spacing (degrees) 

Latitude of the South Pole 

Longitude of the South Pole 

Grid Projection number  
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Scanning mode  

 

 

Figure 82 Example of Grid Modify for WRF Model 
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4.2.9.3 MODEL DELETE 

By clicking on  “Delete” of the Forecast Model menu the system displays  the following GUI: 

Figure 83 Model Process Delete 

There are two ways of deleting a model: 

Delete: deletes the model only if it is not linked to products such as: verifications, graphs, scores  

Force Delete: delete the model and all related products. 

4.2.10 SUSPECT OBSERVATION 

The suspect value configuration can eliminate pairs of observation/model data causing problems during 

calculation of scores. User can create a new suspect value condition, modify or delete it. By clicking on 

Suspect Observation -> Registration user can set limits to the absolute value of forecast- observation 

difference. Suspect values can be retrieved and saved in text files (see Report Menu). 

Figure 84 Suspect observation Registration 
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Figure 85  Suspect Observation Modify List 

 

Figure 86 Suspect Observation Modify menu 
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Figure 87  Suspect Observation Delete Menu 

 

User can modify or delete a suspect observation value. 

 

4.2.11 GEOGRAPHIC MAP 

The Geographic map menu is used to configure the plotting of graphics related to verifications based on 

geographical scores calculation. To configure a geographic map the system needs the map in png format 

and the related graphic information. By clicking on Geographic map the system automatically displays  the 

GUI for map modifying: 
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Figure 88 Geographic Map Modify 

VERSUS system includes  a set of maps created for every COSMO partner. Each map information can be 

displayed by clicking on report icon, or modified  by clicking on Modify  icon‘.  

For example: 

1) by clicking on report  icon of Italy Map the system displays: 
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Figure 89 Geographic Map Report 

The available information is: 

Description: The name of the map 

File name: the name of the uploaded  map file 

lat.low.left: latitude of the lower left boundary of the map 

lat.upper.right: longitude of the upper right boundary  of the map 

lon.low.left: longitude of the lower left boundary  of the map 

lon.upper.right: longitude of the upper right boundary  of the map 

N. of x pixel: number of the x-pixels of the map 

N. of y pixel: number of the y-pixels of the map 

Show Map: by clicking on this icon, downloading of the map for viewing is possible  

2) By clicking on Modify icon of Italy Map the system displays: 
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Figure 90 Geographic Map Modify 

On this form it is possible to modify the information previously set. New settings will be registered by clicking 

on ‘Update’. 

3) By Clicking on Delete icon of Italy Map the system deletes the related map. 

To register a new map, user should Click on Geographic map->Registration and the system displays the 

following form for map registration. The  required information is: 

Figure 91 Geographic Map Registration 

Map Description: A generic description of the map 

lat.low.left: latitude of the lower left boundary of the map 

lat.upper.right: longitude of the upper right boundary of the map 
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lon.low.left: longitude of the lower left boundary of the map 

lon.upper.right: longitude of the upper right boundary of the map 

N. of x pixel: number of  x-pixels of the map 

N. of y pixel: number of y-pixels of the map 

Select background file: By clicking on this icon, the system gives the capability to upload  a map  (in png 

format) with  the features described in  the above fields .  

 The map should  be in cylindrical projection.  

Currently in VERSUS   there are available maps for each COSMO partner.  

 

4.2.12    FF Model Source 

In the FF the model concept is expressed as a simple description of it. Therefore, no model configuration  is 

required into VERSUS. The system automatically loads into the database the model described in FF. 

Clicking on Configuration->FF Model Source, the system displays the list of models that have been dealt 

with by the loader FE 

Figure 92 FF Model Source List 

By clicking on “Configuration->FF Model Source->Delete” the system shows the following check list.  
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Figure 93 FF Model Delete 

 

To delete an FF model  the user can select one or more models from the list: 

Clicking on “Delete” button, the system remove the model if no connected information are present; 
Clicking on “Force Delete” button, the system remove the model and all connected information except the 
configured verifications which shall be searched and removed by the user clicking on “Report->Verification 
Removal”. 

 

4.3 VERIFICATION MENU 

It is the menu for the system verification configurations. By Clicking on “Verification” menu option the system 

displays: 

 

Figure 94 Verification Menu 
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This menu block allows configuration of the verifications that VERSUS manages. 

 

4.3.1 STANDARD VERIFICATION 

Verification is the process to identify the quality of a forecast, when compared, or verified, against the 

corresponding observations or model analysis data.  

Versus creates four types of standard verifications for forecast comparisons with:  

• on-site station observations  (on site) 

• model analysis gridded data  (Analysis) 

• Ensemble Probability Scores (EPS) 

• Feedback files Verifications. (FeedBackfile) 

 

 

4.3.1.1 STANDARD VERIFICATION on-site 

To create a standard verification using a group of on-site station observations (stratification), the user has to 

click on option “Standard” ->On-site of Verification menu, and  the system displays  the following form: 
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Figure 95 On-site Standard Verification Registration  

 

To create an on-site standard verification, the following information is needed: 

Criteria Type: it can be Surface or Upper air. 

Description: a name to identify the verification.  

Stratification: the ensemble of stations for scores calculation.  

Date/Frequency: a data time series defined either by start and end date or by a periodical timescale which  

can be ‘monthly’ or ‘seasonal’, and is based either on observations or on forecasts. 

Steps: start, end and interval step for verifications.  The interval step must be consistent with the frequency of 

available model outputs and observations.  

In particular for precipitation verifications the steps must be the following: 
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For 24hourly precipitation: start=24, end=end of simulation, step=24 

For 12hourly precipitation: start=12, end=end of simulation, step=12  

For 6hourly precipitation: start=6, end=end of simulation, step=6 

By clicking on (….)   information on initial Run time of mostly used models is displayed together with 

precipitation time steps 

Observation: observation parameter.(parameters with different TRI are available) 

Model: the model to verify 

Run: the model run 

Grid: the latitude and longitude boundaries of the selected model grid . 

Parameter: The forecast parameter  

Method: selection of  the  model interpolation  method ex. : nearest point or  average value of points within  a 

circle of radius R. 

Index: Versus manages two kinds of variables : continuous and  dichotomous. By selecting ‘continuous’ or 

‘dichotomic ‘ index a list of scores appear by for each case by clicking on (….) and selection can be 

performed. If CIs are inserted by user (see index menu) they also will appear on this lists. 

Figure 96 Indexes for Continous/ Dichotomous variables 

  

 For dichotomous parameters, a set of thresholds also needs to be specified, and  the system calculates the scores 

for each of them. Performance diagrams are also automatically produced  
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Figure 97 Thresholds for dichotomous variables 

 

Suspect Value: if continuous index is selected, the option for suspect values detection can be activated..  

Geographical Score calculation: if the box is checked the system calculates the scores for every  station  

included in the stratification and gives the possibility to plot the results in the already configured map. It may 

take a little longer for the verification to be created. Option available only for surface data. 

Example. 

To create a Data interval verification on Temperature surface data from 01 August 2011 to 31 August 

2011 user needs first  to  check data availability for  both forecast  and observation surface data of that time 

period (see Data Availability Menu) 
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After checking forecast data availability it is  important to select the same interpolation method  of the dataset  

on the verification registration form.  

Figure 98 Standard Verification - continuous index - geographical distribution 

 

Data availability check is done also automatically when a verification is created, ONLY for verifications  of 

specified time period(like this example) and NOT for periodical ones  (monthly or seasonal).  
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Figure 99 Verification Report 

 

 

The system displays the related report with all the verification information. It is recommended to retain the 

number id of each created verification in order to search it faster when you need to retrieve it. 

 

The ‘Execute’ button appears only when data are available and only if the verification is Date Interval (like this 

example). If the verification is periodical, the report can be saved in ‘Verification Archive, where it can be 

retrieved in order to run the scores for each month or season (See Report menu). By clicking on “Execute” 

button at the bottom of the page, the system runs the scores By clicking on ‘Duplicate’ button a new Verification 

GUI with the already set parameters opens, so the user can create a similar verification by changing only few 

parameters. 

 

The calculated scores are displayed on a new page, so user can save them in an ASCII file or in an Excel file. 
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Figure 100 Score Report 

If the geographical distribution box is checked, the system calculates the scores for each individual station. 

(See also Report Menu-> Standard Verification Search) 

 

 Versus is able to configure the verification plot by clicking on “Configure” button. 

To configure the plot Versus displays different web GUI related to the type of data and index. 

 Surface data with continuous index 

 Surface data with dichotomous index 

 Upper air data with continuous index 

If user re-runs the scores, the previous scores are deleted and recalculated. 

For periodical verifications, the user should first check if there are available data for each timescale  (month 

or season), by the Data Availability option of the Report menu. 

Periodical verifications (monthly or seasonal) can be executed in two ways: 

 by means of batch execution 

 on-demand through Web GUI . 
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Figure 101 Graphic configuration for Verification with Continuous index 

Continuous  scores graphics 

For graphic configuration of continuous index user can select: 

• The generic title  

• if check for plotting the number of paired data 

• if check for plotting data as line or bar 

• A data range  

• A title for x axis 

• A title for y axis 

• Color and style for each line in the  plot 

Finally, by clicking on Run button the graph is created as shown in the following figure: 
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Figure 102 Preview of  Verification Plot with Continuous index 

 

 Confidence Levels for continuous scores are plotted on the same graph  

Figure 103 Example of Continuous score plot with CIs (plotted on the same graph) 
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Dichotomous scores graphics: Two types of dichotomous scores can be created:: 

By step, where x-axis represents time steps and lines or bars are plotted for different thresholds. 

By threshold, where x-axis represents threshold values and lines or bars are plotted for different timesteps  

Figure 104 Dichotomous graphic configuration 

Figure 105 Graphic configuration By Threshold 
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Figure 106 Example of line graphic by threshold 
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Figure 107 Graphic Configuration by Step (bar) 
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Figure 108 Example of bar graphic by step 

 

Figure 109 Example of Performance Diagram 
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Performance Diagrams for each threshold are automatically calculated and can be downloaded by 

retrieving the Verification (see Report Menu) 
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The confidence levels for dichotomous scores are calculated in different plots  
 
  

Figure 110 FBI, FBI high, FBI low  
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For probabilistic models the system configures automatically as many verifications as the members 

the user selects. By selecting a probabilistic model the system enables the member selection menu 

as follows: 

Figure 111 Standard Verification Registration for probabilistic model 
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By clicking on  ‘Save’ the system displays  the reports of the created verifications : 
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Figure 112 Standard Verification Report for probabilistic model 

For Upper air type criteria the system displays the following form: 

Figure 113 Standard Verification Registration for upper air data 

 

To configure a Standard verification on upper air data the user  needs to enter the same information as for 

the surface data, change  the Criteria Type field to “Upper air” and  select the  levels of interest. The verification 

is performed between radiosonde data in BUFR format and model data on pressure levels. 

By clicking on ‘Save’ button, and assuming that data are available to calculate the scores, the system  displays 

the following GUI for this data interval example. 
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Figure 114 Standard Verification Report for upper air data 

 

By clicking on Execute button the system runs the scores and a  GUI appears, displaying  the results which 

can be saved  in text or excel format: 
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Figure 115 Standard Verification Score for upper air data 

If the Verification is configured for Date Interval at the end of the page it is possible to configure the plot  by 

clicking on Configure button, and  the system displays  the following GUI: 
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Figure 116 Standard Verification Graphic Configuration for upper air data 

 

 

By clicking on Run button the system displays  a graph that contains all steps plotted at the same time, and a 

list of individual plots   for each step configured in the verification: 
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Figure 117 Standard Verification Graphic for upper air data-global plot 

 

Figure 118 Standard Verification Graphic for upper air step-6 
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4.3.1.2 Analysis STANDARD VERIFICATION 

To create a standard verification using analysis data , the user must  click on  option “Standard” ->Analysis 

on verification menu, and  the system displays the following GUI: 

 

Figure 119 Analysis Standard Verification Registration 

To create a standard verification based on gridded data , the following information is needed: 

Criteria Type: it can be Surface or Upper air. 

Description: a name to identify the verification.  

Stratification: the ensemble  of stations for scores calculation .  

Date/Frequency: a data time series defined  either by start  and end date  or a periodical timescale that can 

be ‘Monthly’ or ‘Seasonal’.  

Steps: start, end and interval time step for verifications.  

Steps: start, end and interval step for verifications.  The interval step must be consistent with the frequency of 

available model outputs  



 VERSUS Page 113 of 235 

 

 

versus@meteoam.it 

 

In particular for precipitation verifications the steps must be the following: 

For 24hourly precipitation: start=24, end=end of simulation, step=24 

For 12hourly precipitation: start=12, end=end of simulation, step=12  

For 6hourly precipitation: start=6, end=end of simulation, step=6 

 

Reference Model Parameter options concern data related to model  to be verified: 

Model: the model to be verified 

FCS Parameter: the reference model forecast parameter  

Run: the reference model run 

Analysis Model Parameter: Contains information on analysis gridded data which are used instead of 

observations: 

Model : the analysis model name   

FCS Parameter: the analysis model parameter 

Hours: By selecting ‘All’, all the available hours  are taken into account for comparison with the reference 

model run,  otherwise the user can select the ones he wants. 

Index: the selection is among the continuous indexes ME,MAE,MSE,RMSE 

Example. 

Creation of a verification on surface Analysis data from 01 August 2011 to 31 August 2011: 
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Figure 120 Surface analysis  Standard Verification 

By clicking on ‘Save’, the system displays  the  new verification report. . 
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Figure 121 Analysis surface Standard Verification report 

 

 

 

 

By selecting   Report ->Verification Archive->Analysis, it is possible to find  the created verification and run it: 
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Figure 122 Analysis surface Standard Verification list 

 

The graphic related to this verification is:  
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Figure 123 Analysis surface Standard Verification graphic 

 

It is also possible to create verifications on Upper Air data, but in this case pressure levels must be selected. 

4.3.1.3 Standard Verification for ENSEMBLE PREDICTION MODEL SYSTEMS 

A Standard EPS Verification calculates probability statistical scores and diagrams for Ensemble Prediction 

model Systems.  
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To register a new Standard EPS Verification, user should click on option Standard (EPS) of the Verification 

Menu, and the system displays the following form: 

 

Figure 124 EPS Verification Registration 

 

To create an EPS Standard Verification the following information is needed: 

Description: a name to identify the verification.  

Stratification :the ensemble of stations for scores calculation.  

Date/Frequency :a data time series defined either by start  and end date  or by a periodical timescale which  
can be ‘monthly’ or ‘seasonal’. 

Period Based: On Observations or forecasts.  

Step: start, end and interval step for verification. For dichotomous parameters it is also possible to verify the 

day/night cycle. For example the night cycle is configured by setting start=0, interval=12. 

Observation: observation parameter .(Precipitation for this example) 

Model: the probabilistic model to verify 
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Run: the model run 

Members : the selected  model members  Selection of Member 0 is also possible. 

Grid: the latitude and longitude boundaries of the selected model grid . 

Parameter: Forecast parameter to verify 

Method : the  model interpolation method 

Thresholds: Specify the Thresholds for scores calculation. User can specify and insert/delete thresholds 

The calculated EPS scores are BRIER, BRIER Skill, Brier Decomposition (Reliability, Resolution, 

Uncertainty), RPS (Rank Probability Score), RPSS (Rank Probability Skill Score), RPS climatology, CPRS 

(Cumulative Probability Skill Score), CPRSS (Cumulative Probability Skill Score), SPREAD, ERROR, ROC 

Area and Outliers.(See Apprendix for short descriptions). Confidence intervals of scores are also calculated. 

The EPS diagrams are ROC, Reliability, Cost Loss and Rank. There is no possibility for selection of  EPS 

scores and diagrams, they are all calculated for each verification. RPS and RPSS scores are consistent 

only with MECE (Multi Category Probability Forecasts) thresholds.  

By clicking on ‘Save’ the verification is created and saved in the Verification Archive., The system checks what 

type of intervals are configured. If intervals are not MECE (as is in the above example) the system converts 

them into MECE for the RPS, RPSS, RPSS.cli calculation. The created verification report is the following: 
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Figure 125 Standard EPS Verification Report 

The system converts the intervals used for the EPS verification into adequate intervals for RPS calculation.   

Similarly to the Standard Verification, the system displays the related report with all the verification information. 

In case of a DATE INTERVAL verification, an availability check is performed automatically and if the specified 

data are available, “Execute” button appears and the system can run the scores.  

If the verification is periodical (Monthly or Seasonal), the report is saved in ‘Verification Archive’, and needs to 

be retrieved in order to run the scores, See  Report Menu- EPS Verification Search). 

In the above example (Monthly Verification) after retrieving the Verification from the archive, the following 

menu for graphic configuration appears: 

Figure 126  EPS Graphic tools menu 
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After clicking on ( )‘Execute’, the calculated scores are displayed , and the  user can view them ( ) 

(Score Report) and save them in an ASCII file or in an Excel file. 

Figure 127 Score report example for BRIER scores 

 

Figure 128  Score report example for RPS score. 

 

By clicking on ( )‘Configure’ option of the menu, the graphic Configuration menu appears and user can 

select configuring the graphic either by thresholds or by steps. RPS, RPS.clim and RPSS values are plotted 

only by steps 
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Figure 129  Graphic configuration menu 

By clicking on ‘modify’ icon the following GUI appears where user can configure each score plot separately 

by selecting the desired one at the top of the page, specifying the y axis scale and the plot features. 
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Figure 130 EPS Graphic Configuration by threshold (the possible scores that can be configured by threshold 

are shown on  top of the form) 

In this graph there is no possibility to activate the ‘Show Option’. The ‘Run’ button plots the scores 
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Figure 131 EPS Graphic Configuration by step (the possible scores that can be configured by step are 

shown on the top of the form) 

 

In this graph there are the options “Show” for drawing or not the connected line and user can select ‘yes’ or  ‘no’. 

In the graphic configuration of RPS, RPSS, RPS.clim, CRPS, CRPSS scores the option “Show” is disabled as 

in the following example for RPSS. 
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Figure 132 RPSS Graphic Configuration by step 
 

 
For SPREAD/SKILL scores configuration. the menu is the following: 

Figure 133 SPREAD/SKILL Graphic Configuration (Option “Show” does not appear) 

 

Examples of line plots of  EPS Scores line plots are given below: 
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Figure 134 Brier  and Brier Skill Scores Plots by Thresholds 
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Figure. 135   Brier Reliability and Resolution by Thresholds 
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Figure 136  RPS and RPSS plots by steps 

Figure 137  SKILL-SPREAD Graphics  

 

Figure138 Outliers score graphic 
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Figure 139 ROC Area score Graphic 

 

Note that for Confidence Intervals of EPS scores, the plots of Ci_high, CI_low are NOT plotted on the same 

graph, but in different ones (like in the case of  dichotomous scores). 

 

 

The EPS diagrams are created automatically and can be downloaded by retrieving the Verification (see Report 

Menu)  
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Figure 140 Examples of ROC and Cost-Loss 

Diagrams 

 

 

 

Figure 141 Attribute Diagrams with confidence interval/ Reliability-Sharpness Diagram 
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Figure 142 Rank Histogram 

 

4.3.1.4 FEEDBACK FILES Verification Registration 

The configuration of a verification based on FF data follows the same rules as the other configurations 

implemented into VERSUS. In order to configure a FF verification the user has to click on Verification->Standard-

>FeedbackFile menu, and the following GUI is displayed: 
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Figure 143 Standard FF Verification Registration 

In order to configure the FF verification the following fields should be filled in: 

Description: a brief description of the verification; 

Type of Data: this field can be TEMP if the verification deals with TEMP data or AIREP if the verification deals 

with AIREP data. According to this selection different list of stratifications will appear in the corresponding section. 

Stratification by stations for TEMP or by area for AIREP; 

Stratification: the stratification on which the verification will be performed; 

Date or frequency: the fixed time period or frequency of the verification; 

Step: the start, end and interval step fields; 

Run: the run of the model; 

Model Source: Selection of the available model sources loaded into the system; 

Parameter: the selection of the available configured parameters; 

State of observation: the state of observation that the verification will take into account during the score 

execution. If no state is selected the verification shall take into account all the available states; (It is better to select 

the state of observation during the FE loading phase) 

Index: the scores to compute  (only continuous) which can be ME, MAE, MSE, RMSE, STDE; 

Levels[hPa]: the  levels expressed in hPa, on which  the scores will be computed.  
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These levels can be set as “fixed pressure levels” or “level bins layers”. In this last case every layer is defined as 

an interval of pressure levels.  

The multi value field  “Selected Levels” is pre-filled with default levels and the user can modify according his needs 

both in single number and layer values  by the “Insert level” as detailed below: 

 

Figure 144 FF Pressure Levels Configuration 

The selection “Equal to” on the ‘Insert level’ menu allows to define a single value level (default selection for 

TEMP) while the selection “From-to” allows to define an air layer (default choice for AIREP) through the setting of 

the lower and upper limit respectively  

The graph configuration follows the rules of the upper air Verification and (see also report menu), and the produced 

graphics are similar to the ones produced by Standard Verification-Upper Air. 

The system provides a panel with a general overview including graphics for all steps and simultaneously the single 

graphic for each step  as represented in the following example: 

 

 

 

Figure 145  FF Graphics Panel Overview 
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Figure 146 FF step 6 zoomed  Graphic 

 

4.3.2 CONDITIONAL VERIFICATION 

A conditional verification is defined as the verification, against a set of observations when specific conditions 

on observations or/and forecasts are applied .simultaneously or independently. 

VERSUS creates two types of conditional verifications:  

• on surface data with continuous scores  

• on surface data with dichotomous scores 

 It is not  possible to create a conditional verification for upper air data, EPS and FF  

To create a conditional verification the user has to provide the information specified in the standard verification 

in addition to the conditions on: 

• Observation Data  

• by Value  

• by Function  

• Forecast Data  

• by Value  

• by Function 

• Both  Observation and Forecast Data 

• by Value  

• by Function 
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In this last case, by default, the menu opens with the option ‘By Value’ for  both observation and forecast data at 

the same time and the user can combine ‘By Value’ and ‘By Function’ options for each of them independently.  

Figure 147 Definition of conditions 

 

 

Condition by Value  

To define a condition on a parameter value lying within a specified window , the user must define one condition 

with “=<>=” (AND). 

To define a condition on parameters lying outside a specified window, two conditions must be specified, the 

first with “=<” and the second with “>=”(OR). To apply a condition on wind direction two ‘OR’ conditions are 

needed in order to specify the direction range. The second condition appears by clicking on button (+) 
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Condition by Function 

The user can define conditions on parameter functions , for example the  values average. 

If the condition applies to the forecast parameter it is also necessary to define the interpolation  method. 

 There is no possibility of conditional Verification for Feedback files and EPS. 

 

4.3.3 WEATHER TYPE DEPENDENT VERIFICATION 

A weather type dependent verification is a verification performed on specified weather class.  

This type of verifications are performed based on: 

 

 onsite observations 

 analysis data 

 

4.3.3.1 ON SITE WEATHER DEPENDENT VERIFICATION 

To create a WDT Verification the user selects on Weather- type menu->Onsite, and  the system displays the 

GUI. The configuration of this type of verification is identical to  a Standard one, with the addition of the 

Weather Type option: 
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Figure 148 WDT Verification Registration 
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The user must select the weather services that are already configured and related weather classes he  wants 

the verification for.  By clicking on button save, the system configures automatically as many verifications as 

the number of weather classes he selects.  The report related to WDT Verification registration is: 

Figure 149 On-site WDT Verification Report 

 

4.3.3.2 ANALYSIS WEATHER TYPE VERIFICATION 

To create a WDT Verification the user selects  on Weather- type menu->Analysis, so the system displays  the 

GUI. The configuration of this type of verification is identical to an analysis Standard one, with the  addition to 

a new section Weather Type: 
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Figure 150 Analysis WDT Verification 

 

 

4.3.4 TIME SERIES 

The time series plot displays the trend of observations, forecasts and scores data in a pre-determined  time 

period. Multiple model forecast trends can be displayed on the same graph. 

By clicking on “Time Series” menu the system displays the GUI for Time Series registration. 

The following information is needed: 

Description: a name to describe the verification.  
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Figure 151 Time Series Registration 

Stratification: the ensemble of selected stations for scores calculation.   

Date / Frequency: a data time series range defined either by start and end date or by a periodical timescale 

that can be ‘monthly’ or ‘seasonal’.  
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Day : 1-day, 2- day or 3 forecast day average data. 

Observation:  observations parameter.  

Model: the first model to verify  

Run: the model run  

Grid: the latitude and longitude boundaries of the selected model grid.  

Method: list of methods of model value interpolation at the observation point such as nearest point, average 

value of grid points within a circle of radius R 

 In case of adding a new model user should click on ‘+’ button on the left bottom of the forecast menu and 

a new forecast menu section appears for a new model configuration. The user can repeat the action for the 

desired number of models.. With the button ‘-‘ user can remove a model from the configuration. 

Index: the list of scores to be plotted as time series. This is an optional field. 

Concerning the accumulated parameters, the system automatically takes into account  the accumulation of 

the previous  24 hours, while  for the others parameters the  00 hour value is taken. 

Clicking on save button the system displays: 

Figure 152 Time Series Report Monthly 
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If the created Time Series report is based on start and end date and data are available in the DB the system  

can configure the plot . Data availability can be verified  as an option of the Report menu. 

Once saved in the system, the report can be found by searching in the Verification archive menu, and the 

graphic configuration has  the following options:  

Figure 153 Time Series graphic configuration 

The configuration of time series plots consists of two parts : 

 the first part set ups the options for plotting observations and  model forecasts  

 the second part sets up  the options for plotting scores.  

By clicking on Run button the system displays the two following graphs: 

The possibility of downloading the observations and forecast values at each time step is also possible. (See 

Time Series Verification Searching on Chapter 4.3-Report Menu) 
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Figure 154 Time Series graphic 
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Figure 155 Time Series scores graphic 
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4.3.5 DAILY CYCLE 

The daily cycle graphic depicts the trend of observation and model forecast data on  a monthly basis  by daily 

time steps. Parameter settings are identical to a time series graphic without the index configuration option. 

Multiple model forecasts can be plotted on the same graph. Daily Cycle Registration and report creation 

procedure is the same as for the Time Series one. 

4.3.6 SCATTER PLOT 

The scatter plots depict  the relationship between two sets of data: observation and forecast.  

Clicking on “Scatter Plot” menu the system displays the GUI for Scatter Plot registration. 

Figure 156 Scatter plot registration 

The information needed is: 

Description:  a name to describe the verification.  

Stratification: the ensemble of selected stations for scores calculation.  

Date / Frequency: a data time series defined either  by start  and end date  or by a periodical timescale that 

can be ‘monthly’ or ‘seasonal’.  

Observation:  observation parameter.  

Model: the model to verify  

Run: the model run  

Grid: the latitude and longitude boundaries of the selected model grid.  

Method:  list of methods to use for model value estimation at the observation point. 

 A graphic is plotted, for each model step  
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By clicking on save the system displays the following report: 

 

 

Figure 157 Scatter plot report 
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The report can be found in the Verification Archive and the  graphic settings are   the following:  

Figure 158 Scatter plot graphic configuration 

The number of produced plots  is equal to the number of model steps: 

 

Figure 159 Scatter plot graphic results-step 0 
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4.3.7 COSI 

The COSMO Index (henceforth called COSI) is a measure of the forecasting skill of the different COSMO 

models implemented in COSMO consortium. 

For more information about COSI see COSI COSMO Index Document.  

Clicking on COSI menu the system displays  the following GUI: 
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Figure 160 COSI Registration 

To register a new COSI verification the following information is needed: 

Description: a name to identify the verification   

Stratification: the stratification for   COSI calculation 

Model:  forecast model name and  run 

Grid: the latitude and longitude boundaries of the selected model grid 

Steps for index calculation of Temperature, Wind, Total Cloud Step.  (Start, end, interval) 

The interval of the Precipitation Step refers to precipitation accumulation hours  

By clicking on button “Save” the system displays  the report of the created COSI: 
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Figure 161 COSI Definition Report 

The  report  displays links to each COSI parameter verifications that compose the index. 

 

4.3.8 CROSS MODEL 

The system  can also create cross model graphics for all  types of verifications. The aim is to group in a single 

plot  two or more scores obtained from different meteorological models. Graphics for probabilistic models can 

are also be produced. By clicking on “Cross Model” menu the system displays  the following GUI verificare: 
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Figure 162 Verification request for cross model graphics 

 

Cross Model Graphic needs a registration procedure where  the information needed is the following: 

• type of data, surface or upper air; 

• Verification type, standard, conditional or Weather Type, 

• type of score, continuous or dichotomous; 

• list of models; 

• run; 

• parameter. 

Cross Model graphics are plots showing index scores from different models. By submitting “Search”  the 

system shows all the configured verifications  which apply to the request:  
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Figure 163 Graphic Cross Model configuration 

In the GUI above the user  can  select from a list of available configured verifications. 

By clicking on “Continue” button the system displays  the list of  time periods of the verifications, and a list of 

calculated indexes. The next step is selection of time periods ,and indexes. By clicking on “Continue”,  the 

following GUI is displayed. (Figure 62) which is an example of registration for dichotomous index plots 
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Figure 164 Graphic Cross Model date and index selection 
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Figure 165 Graphic Cross Model graphic configuration 

 

 By clicking on “Run“ the  plots of the selected indexes are created.  

 

4.3.9 MONTHLY GRAPHIC 

This type of graphic depicts the trend of the monthly scores. By clicking on “Monthly” option  of the 

“Verification” menu the system displays  the following GUI: 

Figure 166. Monthly graphic registration 

 The scores search is performed by entering the desired period (start and end month). To refine  the request,   

the  model, its run, the parameter and  index can be selected. By clicking on “Search”  the system displays  

the  requested information.: 
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Figure 167 Score request results. 

 

By entering  “Continue”  the system displays  the GUI for monthly plots configuration: 
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Figure 168 Monthly graphic configuration 

By entering ‘Run’the plots foreach forecast day are displayed:  
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Figure 169 Monthly graphic 
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4.4 REPORT MENU 

Figure 170 Report menu 

 

The Report Menu manages all data and graphical reports available in VERSUS system.  

 

4.4.1 DATA AVALIABILITY 

It is possible to check the availability of data (forecasts and observations) and download them in ASCII, Excel, 

or grib1 format 

By clicking on Data Availability option the system opens two sub-menus: 

1) On-Site: for checking the data availability  related to Front End that deals with bufr and ASCII synop, buf 

rand ASCII temp formats, and forecast model data on specified stratification 

2) Analysis: for checking analysis data availability  related to Front End that deals with grib in raw format 

(area_grib) 

4.4.1.1 DATA AVALIABILITY On-Site 

By clicking on Data Availability On-site, the system displays:  
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Figure 171 FCS Data availability on-site search All Italian stations 

 

Stratification: User can search for data of  a specific  stratification or a set of stations inside a set of 

stratifications. To search for  stations that match  a specific criteria the field “Substring searching” should  be 

filled in. In the form  above  a search on the “All Italian stations” stratification is performed and the criteria of 

station sub-search is “16%BR”. By clicking on  ‘find’ the system displays on “Available Stations” field the list 

of stations that match the  substring. The user can now  select the stations he  needs in the data availability 

query  by clicking on >> button. 

Criteria Type: User can check the data availability for forecast data, surface or upper air observation data. 

Data: start date and end date of the time period of interest. In case these fields are  empty,  the system 

displays  all available data without taking into account time range.  

Model: Only for forecast data. The user needs to  specify the model and it is the only mandatory field. If the 

model is probabilistic, the system displays  the list of its members, and user can select one or more. 

Run: Only for forecast data. It is the model run 

FCS Parameter: only for forecast data. The list of parameters that are checked for availability  

Method:  Appears only for forecast data. Selection from list of interpolation methods of the model data 
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Group by: the data can be  grouped by day or month  

By changing criteria type to  “Upper air Observation” the system displays  the following GUI: 

 

Figure 172 OBS Data availability request 

 

Then, user can select  the options for observation search.  

By clicking on ‘Search’ button of an FCS criteria type, the system makes a query in the database to verify the 

model data availability.. 
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Figure 173 FCS Data Report: Availability 

From this GUI it is possible: 

 To delete selected data by clicking on “Delete” button 

 To download the data in Text or Excel format 

A special attention should be given to the observed precipitation  parameter. A download request of 

precipitation observation implies that the system automatically gets 6,12, or 24 hours accumulated 

precipitation .  

 

 Search for FF data loaded into VERSUS DB, is done by clicking on “Report->Data Availability-

>FeedbackFile”. The GUI that appears is: 
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Figure 174 FF Data Availability Search 

 

The GUI gives the possibility to select: 

Criteria type: if data to search are TEMP or AIREP; 

Stratification: the stratification of the data; 

Data: the reference date interval  

Source Model: the FF source model description; 

OBS parameter: The list of parameters that are checked for availability 

Group by: the data can be grouped by day or month  

Clinking on the “Search” the system displays  the following GUI: Data can be downloaded in text files or deleted. 

 

Figure 175 FF Data availability Report 
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4.4.1.2 DATA AVALIABILITY Analysis 

By Clicking on Data Availability On-site, the system displays  the form for searching data related to the 

ingestion of grib data useful for analysis verification. 

Figure 176 FCS Data availability analysis searching 

 

Criteria Type: User can check the data availability for  surface or upper model data. 

Data: start and end date of the period of interest, In  case the fields are left empty, system shows all available 

data without taking  into account time range.  

Model: The user must  specify the model and this  is the only mandatory field.  

Run:  the model run 

FCS Parameter: The list of parameters that user wants to  check for availability 

Group by: the data can be grouped by day or month  

By clicking on search button the following form is displayed: 
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Figure 177 FCS Analysis Report: Availability 

 

From this GUI it is possible to delete selected data by clicking on “Delete” button. 

4.4.2 VERIFICATION ARCHIVE 

The menu “Verification Archive” manages the scores and graphics results of all the verifications that VERSUS 

has carried out. Verification archive menu consists of two sub-menus: 

On site: for submitting a request for verifications based on on-site stations. 

Analysis: for submitting a request  for verifications based on gridded data. 

4.4.2.1 VERIFICATION ARCHIVE On-site 

By Clicking on “Verification Archive”->On-site the system displays : 
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Figure  178. Verification Archive on-site 

 

The GUI above can search for verifications in two different ways: 

 by Verification ID: on  this type  of request  the user must  click on “Active ID Criteria”, fill in  the field 

Verification ID, and the  fields related to the time period. The verification ID  can be found in the 

report form. This kind of  request can locate a specific verification independently of the type 

(Standard, Conditional, Weather Type, Time Series, Daily Cycle, Scatter plot, COSI, Cross, Monthly, 

Standard (EPS) )  

 by Field: on  this type  of request,  the user has to fill in the fields appearing on  the GUI  which 

depend on of the type of verification checked.  

All verifications requests have in common the following fields to specify: 

Description: a verification can also be searched with  a substring contained in its configuration description.  

Verification: it is a mandatory field in which the user must specify the kind of verification he wants to search 

for., The values are Standard, Conditional, Weather Type, Time Series, Daily Cycle, COSI, Cross, Monthly. 

Criteria: the user has to specify if the verification is on Surface or Upper air data. The whole set of verifications 

is defined on surface data except for Standard and Cross which can be defined in upper data also. 
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Stratification: this field is needed for specifying  one or more stratifications for verification search. If  left empty 

the system will  perform the search for all the available stratifications. 

Date: the time interval on which to perform the verification search. It is mandatory if frequency is set to Monthly 

or Seasonal.  

Frequency: this field can be set to Monthly for a request of  verifications configured as Monthly, Seasonal for  

verifications configured as Seasonal or Date interval for  verifications configured in a defined time period. 

Model: this field is needed to select  one or more models used for the verifications. If left empty the system 

will perform a  search for all the available models. 

Run: this field refers to the model run 

OBS Parameter: (except for COSI) this field is for selecting  one or more parameters for verification search. 

If left empty the system will perform a  search for all the available parameters. 

At the end of form there are two options : 

 Search: for  submitting the  search request 

 Reset: for  resetting the fields previously  set. 

4.4.2.1.1 Standard Verification Searching 

Additional fields for this type of query are: 

Statistical Index: this field can be set as dichotomous or continuous or both 

Method: this field  is for selecting one or more interpolation methods. If left empty the system will perform the 

search for all the available methods. 

Suspect Value: if the option ‘Activated’ is checked the search will include only verifications configured with the 

option of  the suspect value control. If ‘Not Activated’ is checked, the search  will include only  verifications 

configured  with the option not to have the suspect value option. To check  both options is  equivalent to 

uncheck both. 

An example of GUI settings for searching  a standard verification is given below: 



 VERSUS Page 167 of 235 

 

 

versus@meteoam.it 

 

Figure 179 On-site Standard Verification Search 

This standard verification search is performed by specifying the following fields: 

Description: not specified.  

Verification: Standard. 

Criteria: Surface.  

Statistical index: continuous 

Stratification: All Italian Stations 

Date: from 2011-03-01 to 2011-08-31  

Frequency: Seasonal. 

Model: COSMOME 

Run: 00 

Method: 1) Nearest Points 3D optimized 

OBS Parameter: 2 Meters Temperature 

Suspect Value: both 
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By Clicking on Search button the system displays  the following web GUI: 

Figure 180 On-site Standard verification list 

For each verification found, the system builds the seasons (or months) and for each of them the following 

information is available:  

 Description: It is the description of the verification found and it is a link to its  complete report   

 Date: the calculated date automatically build from the system 

 Data Avail. To get information concerning the number of matching data (obs fcs). By clicking on this 

icon the system automatically calculates the number of matching pairs. 
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 Suspect Obs: in case of  suspect observations ,is a link to them in order to visualize them and 

download them by clicking on ‘Save Text’ 

 

 

 

 

 

 

 

 

Figure 181 Suspect Observations 

 

Numeric Results:  Click on this icon for  running or rerunning the scores, if data is available and only if 

the current user is not  a consultant   

When running a verification, from Report->Verification Archive, the link  appears. This icon 

indicates that the verification is in the process of computing the scores. 

Figure 182 Process of Running a Verification 

 The refresh of this GUI can be forced by clicking on the “Refresh” button, In any case, the page is 

automatically reloaded after 60 seconds. If the verification has correctly ended the traditional Versus view 

will appear.  

 During the execution clicking on the icon the system redirects to the Queue Manager page, 

with the details of the current verification and of the ones that are currently running.  

 Numeric Results:  for analyzing or saving the calculated score  

 Graphic-Modify: for configuration of the plot as standard graph and  for  geographical graphical 

distribution 
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 Graphic-Show: for displaying   the standard plot for showing the geographical plotting 

 Graphic-Delete:  for deleting the plot, only if the current user is not  a consultant  

 Graphic-Download  for downloading all plots either standard or geographical (.png format)The files are 

stored in the Verification Archive critera_ID.zip where ID is the Verification ID number. The files can be 

alternatively downloaded directly from the file system from the path $HOME_VERSUS/html/versus 

Figure 183 Standard Verification list for dichotomous parameters with Performance Diagrams 

For dichotomous parameters, performance diagrams (PD) are also produced. By clicking on  a list of 

PD for each threshold is available and can be downloaded in PDF format. 

 

To configure a geographical plot of a verification, it needs to have been created with “Geographical distribution 

” option set to on. In the list of verifications, the icon of the geographical distribution appears.  

By clicking on icon the system displays : 

 

Figure 184 Geographic plot configuration 

The information needed is: 

Title: the title of geographical map distribution  
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Geographic Map: the geographic map on which the scores will be plotted 

Steps: day or night/day cycle 

By running the registration the system displays as  many graphics as the days of the model for each  

configured score, The figure below displays  a graph of ME index geographical distribution of the first day (0-

24 steps) . X-axis represents longitude values, and y-axis latitude values, : 

Figure 185 Geographic distribution graph 

 

The graphic colors and legends can be changed by editing the file RGBdefine.php located in the directory: 

 

${VERSUS_HOME}/html/versus/ 

For each score and for each parameter there are two variables to edit: 

global $COLOR_XXXXX_SCORE; It is the colors array that contains the colors coded into RGB code. 

global $LEGEND_XXXXX_SCORE; It is the legend array that contains the intervals of legends. 

 

XXXXX is the bufr code of the parameter and SCORE is the name of the score. 
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When the variables are not specified the system uses the default option: 

global $COLOR_OTHER; 

global $LEGEND_OTHER 

Referring, as an example, to continuous scores, in the file “RGBDefine.php” disseminated with the VERSUS 

packages, default color and legend  for ME of Temperature (bufr code 12004), are configured through the variable 

$COLOR_12004_ME and $LEGEND_12004_ME. The graphic for the other continuous scores are, also produced 

based on the general variables described above. 

 

A detailed procedure to configure these properties for a new index follows, using as an example, configuration of 

color and legend array for the Standard Deviation (SD) of the Temperature. According to this procedure the user 

can configure any other “parameter-index” couple (continuous or dichotomous). 

In general the user can change color or legend, but in order to make the                                                      

changes operational, in any case, he must define both arrays. 

 

The steps are the following: 

 

1. Edit the file “RGBDefine.php” 

2. To configure the legend arrays: add two rows in the file, the first  declaring the variable name and the second 

filling the array with the  user requested values, as follows  

 

 global $LEGEND_12004_SD; 

$LEGEND_12004_SD=array("2.1,2.0","2.0,1.9","1.9,1.8","1.8,1.7","1.7,1.6","1.5,1.6","1.5,1.4","1.4,1.3","

1.2,1.3","1.3,1.2"); 

 

3. To configure the color arrays: add two rows in the file, the first one  declaring the variable name and the second 

filling the array of colors with the  user requested values, as follows 

 

global $COLOR_12004_SD; 

$COLOR_12004_SD=array(array(84,3,11),array(255,255,0), array(248,6,31) ,array(246,102,117), 

array(235,193,239),array(156,215,241) ,array(9,166,248), array(103,6,249),  array(13,63,243), array(5,36,148)); 

 

In this simple example the arrays have been changed with respect to those initially defined for ME, in order to have 

a legend ranging between 1.2 and 2.1 with steps of 0.1 and  the color array has been changed to associate the 

colour yellow RGB “255 255 0” to the interval [2.0,1.9]. 

 

 

4.4.2.1.2 Feedback files Verification Search 
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To search a FF Verification, the procedure is similar to a standard Verification, with selection of “Report-

>Verification Archive” menu. Feedback File button should be selected on the Verification menu and  criteria fields  

:are TEMP or AIREP. According to the fields, the stratification type is different (stations or area defined): 

Figure 186 FF Report Search 
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Clicking on Search Button the GUI is displayed and the scores can be plotted in the same way as standard 

verification. 

Figure 187  FF Verification Search Report 

 

 

4.4.2.1.3 Conditional Verification Search 

Additional fields for this kind of search are: 

Statistical Index: this field can be set as dichotomous or continuous or both 

Method: this field  is for selecting one or more interpolation methods. If left empty the system will  perform the 

search for all available  methods. 

Condition: a verification can be searched for condition on Observation (based on value or function) or 

Forecast(based on value or function) or both. In this last case user should check the “Condition Obs&Fcs”. 

 

Suspect Value: if  ‘Activated’ is checked, the search  will locate only the verifications configured for  suspect 

value. If‘ Not Activated’ is checked, the search will locate only the verifications configured  not to have the 

suspect value. Checking both is equivalent to uncheck both. 
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Figure 188 Conditional Verification Search 

 

An example of GUI settings for a conditional verification search is given below: 

This conditional verification search is performed by specifying following fields: 

Description: not specified.  

Verification: Conditional. 

Criteria: Surface (it is fixed).  

Statistical index: continuous 

Stratification: All Italian Stations 

Date: from 2010-09-01 to 2011-01-31  
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Frequency: Seasonal. 

Model: COSMOME 

Run: 00 

Method: 1) Nearest Points 3D optimized 

OBS Parameter: T2m, TD2m 

Condition: on Observation by value 

Suspect Value: both 

By Clicking on Search button the system displays a web GUI similar to that described for standard verification. 

 

4.4.2.1.4 Weather type Verification Searching 

The fields for this kind of search are the same as the ones of standard verification in addition to the following: 

Weather Service: select  a weather service  

Weather Class:  select one or more weather classes of  the weather services . If left empty the system will 

configure the research for all the weather classes 

An  example of GUI settings for a request of a weather type verification is the following: 
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Figure 189 WTD Verification Searching 

 

By Clicking on Search button the system displays a web GUI similar to that described for standard verification. 

4.4.2.1.5 Time Series Searching 

The fields for this kind of search are the same as the ones for standard verification without the specification 

of the statistical index. When the verification is retrieved, and executed, by clicking on  

      besides the graphic .png files, a .csv file stores the values of observations and forecast values for 

each time step for all models (in case of multiple models time series). The files are stored in the Verification 

Archive critera_ID.zip where ID is the Verification ID number. 

4.4.2.1.6 Daily Cycle Searching 

The fields for this kind of search are the same as the ones for time series verification  

4.4.2.1.7 Scatter plot Searching 

The fields for this kind of search are the same as the ones for time series verification  
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4.4.2.1.8 COSI Searching 

By Checking COSI on field verification of Verification Archive, the fields for COSI search are displayed...  

. 

 An example of GUI settings for searching a COSI verification with the minimum possible input fields is given 

below: 

Figure 190 COSI Verification Searching 

 

The user needs  to specify: 

Stratification  

Start date: the initial year and month of COSI calculation 

End date: the final year and month of COSI calculation 

Model: the process model and related run  

By Clicking on Search button the system displays  all the  COSI that apply , displaying  the following form:  
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Figure 191 Search COSI Index Results 

 

On the above form it is possible to do the following: 

To View the COSI Index definition by clicking on COSI Description 

In the GUI above all data are available but no scores have been executed, For each month the system shows 

if scores and data are available. It is possible to view or execute the monthly scores by clicking on link 

“Scores”. In this case, clicking on link “Scores” of the month of September the system displays: 

 



 VERSUS Page 180 of 235 

 

 

versus@meteoam.it 

 

Figure 192 COSI Scores execution 

From the above form it is possible to run a single score, or rerun an existing one. 

By Clicking on “Trend” link of the Figure 139 the system displays: 
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Figure 193 COSI Trend execution 

 

From the above form it is possible to execute the missing score on  the configured date by clicking on  

icon. Moreover it is possible to get the trend graphic clicking on  icon. For example by clicking on  

Temperature scores the system displays: 
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Figure 194 COSI Trend graphic configuration 

 

By Clicking on the image the system displays  the index trend: 
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Figure 195 COSI Trend graphic 

 

It is possible to run the complete COSI execution by clicking on  of the Figure 139.After execution, by 

clicking on icon the system displays  numeric COSI results, as follows: 
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Figure 196 COSI numeric results 

  

 

For graphic configuration the user must  click on  icon of the Figure 139. 

Figure 197 COSI graphic 

4.4.2.1.9 CROSS Search 

By selecting ‘Cross’ on field Verification of Verification Archive, the fields for Cross search appear.  

An example of GUI settings for  a Cross verification search with minimum input fields is given below: 
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Figure 198 CROSS Searching 

By Clicking on Search button the system displays all the defined Cross model graphics that  apply,  displaying 

the following form:  
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Figure 199 CROSS Model Graphic Show 

Moreover, for each CROSS graphic it is possible: 

 To modify the plot  

 To show the plot  

 To delete the plot  

 

4.4.2.1.10 Monthly Report Search 

By  selecting ‘Monthly’ on field Verification of Verification Archive,  Monthly Report fields  appear.  

An example of GUI settings for a  Monthly graphic request with minimum input fields is given below: 
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Figure 200 Monthly Graphic Search 

By clicking on Search button the system displays  all the defined Monthly  graphics that apply, displaying  the 

following form:  
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Figure 201 Monthly Graphic Search 

For each monthly graphic the system displays  the following information: 

 The monthly description 

 The date  the graphic refers to 

 The standard verifications involved in the plot  

Moreover, for each monthly graphic it is possible: 

 To modify the plot  

 To show the plot  

 To delete the plot  

 

4.4.2.1.11 EPS Standard Verification Search 

By Clicking on “Verification Archive”->On-site the system displays the following GUI for Report Search. The 

user must specify ‘Standard EPS’ on the Verification Menu, the date interval for the Verification Search and 

the model run. The remaining fields are optional.  

An example of GUI settings for an  EPS Verification request with minimum input fields is given below: 
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Figure 202 EPS Report Search 

 

By clicking on Search button the system displays all the configured EPS Verifications that apply, displaying  

the following form:  

Figure203 List of available EPS Verifications 

Similarly  to the previous Verifications, the following options are displayed: 

 Numeric Results:  for running or rerunning the scores, if data is available  and only if the current user 

is not  a consultant  

 Numeric Results:  for analyzing or saving the calculated scores including also ROC Curve, Reliability 

diagram, rank histogram and cost-loss curve. (The txt box saves them in txt format) 
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 Graphic-Modify: for configuration of the plot as standard graph 

 Graphic-Show: for displaying   the standard plot . 

 Graphic-Delete:  for deleting the plot, only if the current user is not  a consultant  

 Graphic-Download  for downloading all  score plots  

 By clicking on “PDF’ icon the EPS diagrams (ROC, Reliability etc) can be downloaded in .pdf format. 

 

4.4.2.2 VERIFICATION ARCHIVE Analysis 

By clicking on “Verification Archive”->Analysis the system displays  the GUI for searching the verification 

 based on analysis data. VERSUS is able to create Standard (surface or Upper) and Weather type 

 surface) verification. 

The GUI can search verifications in two different ways: 

 by Verification ID: for this kind of search the user must  click on “Active ID Criteria”, fill in  the field 

Verification ID, and the  fields related to the time period. The verification ID can be found in the 

report form. This kind of search aims to find a specific verification independently of the type 

(Standard, Weather Type)  

 by Field: for this kind of verification the user has to fill in the fields of the GUI that are specific of 

the type of verification checked.  

4.4.2.2.1 STANDARD VERIFICATION on Analysis 

The search for analysis standard verification  is performed by the following GUI: 

Figure 204 Analysis Standard Verification Search 
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 The following fields must be set: 

 Verification: Standard or Weather type 

Description: a verification can also be searched by  a substring contained in the configuration description 

.  

Criteria: the user must select if the verification is on Surface or Upper air data.  All the verifications are 

defined on surface data except for Standard and Cross.  

Date: the interval data on which search for  the verification. It is mandatory if frequency is set to Monthly 

or Seasonal.  

Frequency: this field could be set to Monthly for searching verification configured as Monthly, Seasonal 

for searching verification configured as Seasonal or Date interval for searching verification configured in a 

defined time period. 

Model: this field aims to select one or more models for verification search. If left empty the system will 

configure the research for all the existing models 

Run: this field refers to model run 

FCS Parameter: for selection of one or more parameters for verification search. If left empty the system will 

perform a search for all the parameters. 

At the end of form there are two buttons: 

 Search: for submitting the query.  

 Reset: for resetting of the specified fields . 

 

 By clicking on Search the system displays: 



 VERSUS Page 192 of 235 

 

 

versus@meteoam.it 

 

Figure 205 Analysis Standard Verification List 

 

The operations that can be executed are the same as the ones for a verification defined on on-site data. The 

calculated grib files with the scores for each step and index are downloadable by clicking on the ‘Down.’ icon. 

They can then be plotted with appropriate tools. By clicking on Download icon the system displays a GUI, 

where grib files for each score and step can be downloaded together with their usual graphic plot. 

 

Figure 206 Grib files and graphic download. 

 

4.4.2.2.2 WEATHER TYPE VERIFICATION on analysis 

By selecting ‘Weather type verification’  the following GUI is displayed: 
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Figure 207 Analysis Standard Verification Search 

By Clicking on Search button the system displays a web GUI similar to that described for standard verification 

in addition to the weather type information. 

The menu “Verification Removal” manages the scores and graphics removal of all the verifications that 

VERSUS carried out. Verification Removal menu consists of two sub-menus: 

On site: for managing the search and deletion of the verifications based on on-site stations. 

Analysis: for managing the search and deletion of the verifications based on gridded data. 

 

4.4.3 VERIFICATION REMOVAL 

4.4.3.1 VERIFICATION REMOVAL On-site 

By clicking on “Verification Removal”->On-site the system displays: 
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Figure 208 On-site Verification Search for Removal 

 

The GUI above  follows the same searching rules of the “Verification Archive” menu. The main difference is 

the output of the search, which  is the following: 
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Figure 209 Verification Delete 

 

The user can check the verification he wants to delete and click on  “Delete” button .the system, then asks for 

a confirmation of the delete operation, and if the answer is OK, the system removes all the verifications 

checked and their  related scores and graphics definitively from the database. Similarly to the standard on-

site Verification Deletion the deletion of the other Verification types is performed. For example : 

 

4.4.3.2 VERIFICATION REMOVAL Analysis 

By clicking on “Verification Removal”->Analysis the system displays: 
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Figure 210 Analysis Verification Search for Removal 

The GUI above follows the same searching rules of the “Verification Archive” menu. The main difference is 

again the output of the search, which is similar to the one described for on site verification removal. 

 

5 FILE NAMES SCHEMAS 

The Verification graphics files are automatically stored in the system by the filename criteria_ID.zip and the 

file names are based on the following rules.  

For continuous scores : 

SCORE_C_(ID_Verification)_STEP_(G).png 

For dichotomous scores: 

D_SCORE_(ID_Verification)_STEP_(G)/TH/ST.png 

Where G= Geographic Map distribution (if applicable) 

ST=Plot for step 

TH=Plot for Thresholds 

Files with .csv extension contain observations and model outputs from time series Verifications. 

For Performance Diagrams: PD_(ID_Verification)_TH.pdf 

For EPS scores 
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E_(ID_Verification)_STEP/TH/ST.png 

STEP is applicable only for the SCATTER PLOT/Geographical Distribution 

EPS verification produces also diagrams in pdf 

 

The pdf file names schema is E_ID_Verification_STEP_startth_endth_pdf 

Where statth and endth indicate the threshold limits.  

 

6 SRNWP DATA POOL– SHORT REFERENCE 

 

6.1 INTRODUCTION 

This brief guide describes how to load obs data from SRNWP data pool project and the correspondent fcs from 

COSMO model. 

At the moment, only radiation and fluxes parameters have been taken into account and all the usual 

functionalities of VERSUS have been implemented (standard and conditional verification, scatter plots, time 

series and daily cycle). 

 

6.2 DATA SETUP 

The observations datasets are available on the COSMO website in a self-descriptive Ascii format, that has 

been adopted as a standard for the dedicated VERSUS Front-End. Nine (9) stations are available in the 

SRNWP data pool Exchange project but only the following have been taken into account as they fall inside 

the COSMO-ME area and/or the datasets are almost complete: Lindenberg, S. Pietro Capofiume, Cabauw, 

Debrecen, Payerne and Fauga-Mauzac. Other stations whose data are available and coded with the same 

ASCII file format can be added easily in VERSUS following the usual procedure. At the moment observation 

data are available up to 2012. 

In order to have the corresponding forecast parameters for comparison, you have to setup the Namelist of 

your model, unless they are already available. 

A table comparing observations and forecasts is given below: 

 
OBS data    FCS data 

RSWD: incoming solar radiation ASWDIR_SAvrg direct downward SW rad  Surface 

RSWU: reflected solar radiation  ASWDIFD_S Avrg diffuse downward SW rad Surface 

     Avrg Balance of SW 

 

RLWD: incoming thermal radiation ALWD_S Avrg downward LW radiation at the surface 

RLWU: outgoing thermal radiation ALWU_S Avrg upward LW radiation at the surface 

     Avrg Balance of LW 

 

HS: sensible heat flux  ASHFL_S: averaged sensible heat flux 

LE: latent heat flux   ALHFL_S: averaged latent heat flux 

 



 VERSUS Page 198 of 235 

 

 

versus@meteoam.it 

 

 

NOTE 1: Balance of SW and LW radiation for observation is internally calculated and stored 

NOTE 2: Forecasts for each step are averaged from the beginning of the run (internally calculated on 1 hour 

interval). Time Range Indicator for this kind of averaged data in GRIB files is 3. 

 

 

 

6.3 MODEL FORECASTS UPLOADING 

 

Grib files have to be loaded from an ad hoc FE created with the usual rules. 

 

Figure 211 FE Forecast Data acquisition process 

 

 Any algorithm for point extraction can be used (mean over a radius around the station is suggested). 

Before uploading grib files, radiation and fluxes fcs parameters should be added. The usual rule to add a new 

fcs parameter in VERSUS has to be used editing grib1.xml file and griboper.xml, by adding the following lines 

respectively. 

 

 

GRIB1.XML: 

 

 -<field name="rswdu"> 

 -<element name="rswdu" unit="rswdu">   

<codeTable>2</codeTable> 

<parameter>111</parameter> 
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</element> 

</field> 

-<field name="rlwdu"> 

 -<element name="rlwdu" unit="rlwdu"> 

 <codeTable>2</codeTable> 

 <parameter>112</parameter> 

 </element> 

</field> 

-<field name="sshf"> 

  -<element name="sshf" unit="sshf"> 

 <codeTable>69</codeTable> 

 <parameter>122</parameter> 

 </element> 

</field> 

-<field name="slhf"> 

 -<element name="slhf" unit="slhf"> 

<codeTable>69</codeTable> 

<parameter>121</parameter> 

</element> 

</field> 

 

GRIBOPER.XML: 

 -<dfieldmissingValue="9999.90" unit="sshf" operation="gribConstantMultiply" name="sshf"> 
 -<coding> 
  <gribTablesVersionNo>69</gribTablesVersionNo>   
 <indicatorOfParameter>122</indicatorOfParameter> 
 </coding> 
 -<element name="sshf“> 
  <codeTable>2</codeTable> 
  <parameter>122</parameter> 
 </element><constant name="var">-1.</constant> 

</dfield> 
 

-<dfieldmissingValue="9999.90" unit="slhf" operation="gribConstantMultiply" name="slhf"> 
 -<coding> 
  <gribTablesVersionNo>69</gribTablesVersionNo>      
 <indicatorOfParameter>121</indicatorOfParameter> 
 </coding> 
  -<element name="slhf"> 
  <codeTable>2</codeTable> 
  <parameter>121</parameter> 
 </element> 
 <constant name="var">-1.</constant> 

</dfield> 
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Once the first set of gribs has been uploaded it is useful to modify forecasts Parameter information from 

VERSUS menu as in the following examples 

Figure 212  Parameter Modify for LW forecast radiation (similar for SW) 

 

Figure 213  Parameter Modify for forecast Sensible Heat Flux (similarly for Latent Heat) 
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6.4 OBSERVATION UPLOADING 

ASCII files have to be loaded from an ad hoc FE created with the usual rules with ‘ SolarObs’ option  at ‘Msg 

Name’.  

Figure 214  Observations Data FE Uploading 
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ASCII files can be downloaded from COSMO website and they have to be edited in order to add the WMO 

code to the SRNWP data pool stations used. Note that Fauga-Mauzac has no WMO code anda fake one 

has been used (VERSUS uses WMO code as a primary key). See the figure below. 

Figure 215 SRNWP stations 

 

The WMO code has to be added in the following way in each first record of the ASCII file containing the 

observation: 

 

#SRNWP data exchange action 
#06610Payerne 46.8137°N 6.9425°E 20110501 00:10 - 20110601 00:00 UTC DATE; 

 

Before the ASCII files are uploaded you need to add Observation Parameters information from VERSUS 

menu as in the following examples: 
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Figure 216 Latent Heat Observation Parameter Definition 

Figure 217 Sensible Heat Observation Parameter Definition 
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Figure 218 LW Thermal radiation Balance Observation Parameter Definition 
Figure 219 SW Solar Radiation Balance Observation Definition 
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Figure 220 LW Incoming Thermal Radiation Observation Definition 
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Figure 221 LW Outgoing Thermal Radiation Observation Definition 
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Figure 222 Incoming Solar Radiation Observation Definition 

Figure 223  Reflected Solar Radiation Observation Definition 

 

 

7 USEFUL internal Links to  VERSUS Software Information 

 

For  information on VERSUS schema, tables and memory allocations  

http://localhost/versus/report 

 

For information  on  VERSUS classes 

http://localhost/versus/html/classes.html 

 

 

APPRENDIX I  (Scores Description) 

A short description of most common score indexes that VERSUS calculates is given below. 

 

DETERMINSTIC FORECASTS 

http://localhost/versus/html/classes.html
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CONTINUOUS SCORES 

Mean Error (ME) The average value of differences between forecast and observed values which calculates trend 

of overestimation or underestimation (Values from -∞to +∞, desired value 0 ME > 0 Overestimation, ME< 0 

Underestimation) 

 

 

 

Mean Absolute Error (MAE) The average absolute value of the differences between forecast and observed 

values. It gives an estimation of the absolute error (Values from 0 to +∞, desired value 0. The smaller  the MAE 

the better the forecast) 

 

 

 

 

Root Mean Square Error (RMSE) The average absolute value of the root of the squared differences between 

forecast and observed values. It gives an estimation of the absolute error with a positive weight to higher 

differences (Values from 0 to +∞, desired value 0.The smaller the RMSE the better the forecast) 

 

 

All the above are also adequately calculated for wind direction (ME, MAE, RMSE for Wind) 

 

 

DICHOTOMOUS SCORES  (based on contingency tables) 

Probability of detection (POD): The number of times an event is correctly forecast divided by the total number 

of observations of that event (Values from 0 to 1, desired value 1) 

False alarm ratio (FAR):  The number of times an event is forecast but not observed, divided by the total number 

of forecasts of that event.(Values from 0 to 1, desired value 0) The opposite of FAR ,(1-FAR ) is the Success Ratio 

(SR)  

Frequency Bias Index (FBI):  The number of times an event is forecast,divided by the total number of  

observations of that event.(Values from 0 to +∞ :FBI> 1 indicates overestimation, FBI< 1 underestimation, desired 

value 1) 

Threat Score (TS): The number of correct forecasts of an event (hits), divided by the total number of forecasts of 

the event (Values from 0 to 1, desired value 1) 
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Equitable threat score (ETS): The threat score (critical success index) adjusted for the number of correct 

forecasts expected by chance.  The score is intended to offset the sensitivity of the TS to the underlying climatology 

of the event.(Values from 0 to 1, desired value 1) 

The Proportion Correct (PC) score gives the fraction of all correct forecasts (event and non-event). It is a 

simplistic and misleading measure since it rewards  equally correct 'yes' and  uninteresting 'no'. 

Heidke Skill Score (HSS). It is a more accurate mesure of the PC, adjusted to eliminate  correct forecasts due to 

random chance 

False Alarm rate (F)  mesures the False Alarms given the observed non-events. 

Hanseen-Kuipers Skill Score (KSS) is defined as POD-F and it is a measure of skill a forecast to distinguish the 

'yes' cases from the 'no' cases. 

Odds Ratio Skill Score (ORSS) is a scaled score with values from -1 to =1 of the OR (odds ratio) which measures 

the forecasting system's probability to score a hit as opposed to the probability of making a false alarm. 

PAG Score is the ratio of hits to the total number of YES forecasts. So it shows the proportion of correct forecasts 

of an event in the total number of forecasts of this event. 

Extreme Dependency Score (EDS) is a score for prediction of rare events. 

Performance Diagram 

On this diagram is possible to exploit the geometric relationships between four measures : POD (y axis), SR (1-

FAR) (x-axis) TS (curves) and FBI (dashed axial lines).. For good forecasts, POD, SR, FBI and TS approach unity, 

such that a perfect forecast lies in the upper right of the diagram. Deviations in a particular direction calculate 

relative differences in POD and SR and consequently FBI and TS An immediate visualization of differences in 

performance are thus obtained. Sample uncertainity is given by the crosshairs. 

 

 PROBABILISTIC FORECASTS 

Brier Score (BS): The Brier Score (BS) measures the average square error of a probability forecast. It is 

analogous to the mean square error of a deterministic forecast, but the forecasts, and hence error units, are given 

in probabilities 

 

N is the number of points in the domain (spatio-temporal) 

Oi =0 or 1 depending on occurrence or not of the event 

Pi= the probability of occurrence according to the forecast system (the fraction of the ensemble members that 

forecasted the event) 
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The Brier score can be represented as the sum of three terms relevant for interpretation of  

sources of errors: Reliability, Resolution and Uncertainity 

The verification sample is partitioned into bins according to the forecast. There are K bins, and K is often 10. 
That is, the verification sample is divided into deciles of forecast probability, all the 0 to 10% forecasts are put 
together with their corresponding observations, 11 to 20% in another group and so on. ok is the observed 
frequency of occurrence of the event in bin k.  

The Reliability term is thus the sum of the squared differences between the forecast probability value for bin k 
and the observed frequency of the event in bin k. One wishes this term to be small for a good Brier score, which 
will happen when the forecast probability equals the observed frequency for all probability forecast bins. This 
forecast is said to be reliable. 

The Resolution term is the difference between the observed frequency in bin k and the overall sample average 

frequency, the base rate, represented by ŏ. This term measures the ability of the forecaster to define his forecast 

bins in such a way so as to separate situations into different types, The resolution term is subtracted, so this is a 

desirable situation. 

The Uncertainty term is a measure representing if an event is common or rare, and ranges from 0 (very common 

or very rare event) to 0.25 (the climatological probability is near 0.5). This latter case introduces more uncertainty 

in the forecasting situation. 

 

Brier Skill Score (BSS):  Measures  the relative skill of the probabilistic forecast over that of a reference forecast 

in terms of predicting whether or not an event. Skill scores have a range of -∞ to 1. Negative values indicate that 

the forecast is less accurate than the reference forecast. "Reference" forecast can be any unskilled forecast; the 

two most often used are climatology and persistence.. 

Where BSref is the Brier Score of the Reference Forecast and BSperf  is the Brier score of the perfect forecast. 

Since the perfect Brier score is 0, the BSS can be written 
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Rank probability score (RPS):  For multi-category probability forecasts (MECE), a measure of the difference 

between the cumulative distribution of forecasts and the observation, summed over all categories.  Measures the 

ability of the probability forecast to predict the category in which the observation fell into. (Accuracy). 

M=the number of forecast categories (eg. Rainfall bins 0-1mm, 5-10mm, etc). 

Ok if the event occurs of not in category k (1 or 0) 

Pk the probability of occurrence in category k 

 

RPS.climis computed from the climatological probabilities 

Rank probability skill score (RPSS): For multi-category probability forecasts,(MECE) the difference in the rank 

probability score for a standard unskilled forecast such as climatology or persistence and the rank probability score 

for the forecast, divided by the rank probability score for the standard forecast. 

CRPS (Continuous Rank Probability Score) It is similar  to the rank probability score, but compares a full 

distribution with the observation, where both are represented as cumulative distribution functions (cdfs). The 

equation for calculation of the CRPS is,  

Where  Fi
f (x)        is the forecast probability cdf for the ith forecast case and Fi

o (x) 

is the observation, expressed as a cdf. If the observation is of a specific value,  then the corresponding cdf is a 

single step-function with the step from 0 to 1 at the observed value of the variable. 

 

The CRPSS (Continuous Rank Probability Skill Score) is a skill score based on the CRPS, and has the normal 

skill score format, 

 

Where the overbars refer to averages over a preferably large sample. The reference forecast is usually climatology 

or persistence. The skill score measures the improvement over the standard forecast, normalized to the total 

possible improvement. The range is -∞ to 1. Since the perfect CRPS score is 0, the skill score can be rewritten as, 
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SKILL/SPREAD relationship. The SKILL (RMSE of the ensemble mean) is plotted against the SPREAD 

(standard deviation of the ensemble). When the spread line is below and far from the skill line then the ensemble 

is considered underdispersive. 

The diagrams that VERSUS performs are the following: 

 

Reliability or Attribute diagram: A plot of the observed frequency of an event (y axis) vs. the forecast probability 

of the event (x-axis). The forecast-observation dataset is binned according to the forecast probability in order to 

obtain estimates of the observed frequency. In a  perfect system the graph is a straight line oriented at 45o to the 

axes. Below this line the probabilities are overestimated and above it underestimated. (mesure of Reliability). A 

dashed horizontal line represents climatology (position of graph mesures Resolution) and a diagonal line between 

climatology and pefect reliability is the ‘no skill’ line. 

  

Sharpness diagram:  A histogram plot of  the number of forecasts vs. forecast probability of each bin.  Usually 

used as an inset to a reliability diagram. Forecast systems that are capable of predicting events with probabilities 

different from the observed event frequency are said to have 'sharpness'. 

 

Relative operating characteristic (curve) (ROC):  It is a plot of the hit rate vs. the false alarm rate obtained by 

building a contigency table for each probability class. It measures the quality of a binary prediction or decision 

based on the forecast probability, based on  different  probability thresholds defining the prediction of the 

occurrence or non-occurrence of the event.  

 

Rank diagram: It depicts how well the ensemble spread of the forecast represents the variability of the 

observations. The N ensemble members are classified from lowest to highest and N+1 bins are created. The 

observations fall into bins and the number of observations into each bin is shown in the figure.  

 

Cost Loss diagram:The improvement of economic value of the forecast is measured relative to the climatology 

forecast and is plotted as a function of the Cost/Loss ratio. For probabilistic forecasts the curve of interest is an 

envelope of curves representing each of the probability  values allowed by the forecast. The lighter curves 

represent the relative value as a function of the cost-loss ratio using each of the probabilities as a yes/no threshold 

for the forecast, while the heavy curve is the outer envelope representing the maximum possible value. 

 

Confidence intervals: The CIs in VERSUS enable estimating sampling uncertainty. There are two main types of 

CIs in VERSUS: parametric and non-parametric. 

The non-parametric techniques utilize the bootstrap resampling,which does not rely on any distributional 

assumptions for the sample; the only assumption is that the sample is representative of the population. The effect 
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of dependence of the sample is equal to sample volume decrease. For most of the scores available with VERSUS, 

CIs are calculated using the bootstrap method, which was proven to have good accuracy. 

All the parametric intervals in VERSUS rely on the underlying sample to be at least approximately independent 

and normally distributed. Most of the dichotomous scores resulting from the outcomes of contingency table have 

binomial distribution, which tends asymptotically to the normal distribution. Thus, the CIs based on the assumption 

of normal distribution are calculated for most of the dichotomous scores, namely EDS, ETS, F, FAR, HSS, KSS, 

ORSS, PC, POD, and TS.  

They are calculated in the following way: 

𝜃 ± 𝑧𝛼/2 ∙ 𝑉(𝜃), 

where 𝑧𝛼/2 is the α-th quantile of the standard normal distribution, and 𝑉(𝜃) is the standard error of the statistic (or 

parameter) 𝜃. Standard errors of most of dichotomous scores can be obtained from R verify function,  

The FBI CIs are calculated using bootstrap (function table.stats.boot) as FBI’s SE is not present in verify function 

(Note that it is possible to calculate CIs in a similar way also for POD, FAR, and ETS). 

PAG is calculated using Wilson’s method suitable for proportions (Gilleland 2010) as its SE is not present in verify 

function: 

 

For more information on the scores and diagrams visit the website 

http://www.cawcr.gov.au/projects/verification 

 

APPRENDIX II XML file Structure and  examples  

 XML Stucture:  Every xml file can contains different <fcs></fcs> tags. The tags are explained in 

the related comment <!--xxx -->.   Parentheses describe the value to be replaced. 

<fcs gribEditionNumber=1> <!--related to one model on a specific grid --> 

<model> <!--model information--> 

 <cd_model_process> (generating Process Identifier) </cd_model_process> 

<!-- it should be fictitious value. It is necessary to classify the origin of the information --> 

<origination_centre> (identification Of Originating Generating Centre) </origination_centre> 

<!-- it should be fictitious value. It is necessary to classify the origin of the information --> 

<n_fcs_ensemble> <model>ensemble_size:model_name=cosmo-7 </model> </n_fcs_ensemble> 

</n_fcs_ensemble> 

<missing_value_code><model>missing_value_code :model_name=cosmo-

7</model></missing_value_code> 

http://www.cawcr.gov.au/projects/verification
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</model> 

<list_element><!-- this tag can be multiple, one for each parameter field of the model--> 

<fcs_element> 

  <code_table> (grib Tables Version No) </code_table> 

  <cd_parameter> (indicator Of Parameter) </cd_parameter> 

  <id_level> (indicator Of Type Of Level) </id_level> 

  <level1> (level1) </level1> 

  <level2> (level2) </level2> 

<time_range_ind> timeRangeIndicator </time_range_ind> 

<base_date><model>base_date:format=xsd,model_name=cosmo7</model></base_date> 

<!-- equivalent to dt_validity and run --> 

<id_method> TBD </id_method> 

<!--it should be fictitious value. It is necessary to classify the origin of the information--> 

</fcs_element> 

 <product><!-- this tag can be multiple, one for each station point--> 

<point_reference> 

   <wmo_block> (wmo block number) </wmo_block> 

   <wmo_station>(wmo station number)</wmo_station> 

<lat><model>grid_point_latitude:location_name=06610, 

location_group=wmo,model_name=cosmo-7</model></lat> 

<lon><model>grid_point_longitude:location_name=06610, 

location_group=wmo,model_name=cosmo-7</model></lon> 

<height><model>grid_point_height:location_name=06610, 

location_group=wmo,model_name=cosmo-7</model></height> 

                        <lsm><model>field:tag=FR_LAND,level=-1, level_class=slev, 

model_name=cosmo-7, location_group=wmo,location_name=06610, lead_time_idx=1 </model> 

</lsm> 

</point_reference> 

<grib _data> <!-- this tag can be multiple, one for each validation date and perturbation number--> 

<grib_value><model>field:tag=T_2M,level=2,level_class=z,model_name=cosmo-7, 

location_group=wmo,location_name=06610,lead_time_idx=2</model></grib_value> 

<validation_date><model>validation_date:lead_time_idx=2,format=xsd, 

model_name=cosmo-7 </model>  

</validation_date> 

<perturbation_number><model>ensemble_member_id:model_name=cosmo-7 </model> 
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</perturbation_number> 

<n_fcs_ensemble> <model>ensemble_size:model_name=cosmo-7 </model> 

</n_fcs_ensemble> 

</grib_data> 

 </product> 

 </list_element> 

</fcs> 

 

 XML Examples 

 

 Example of XML template corresponding to the minimal solution that is already supported by 

fieldextra 11.3 (all model and parameter information provided manually): 

 

<fcs gribEditionNumber=1> <!--related to one model on a specific grid --> 

<model> <!--model information--> 

 <cd_model_process> 107</cd_model_process> 

<origination_centre> 215 </origination_centre> 

<n_fcs_ensemble> <model>ensemble_size:model_name=cosmo-7 </model> </n_fcs_ensemble> 

<missing_value_code><model>missing_value_code :model_name=cosmo-

7</model></missing_value_code> 

</model> 

<list_element><!-- this tag can be multiple, one for each parameter field of the model--> 

<fcs_element> 

  <code_table> 2</code_table> 

  <cd_parameter> 11 </cd_parameter> 

  <id_level> 105 </id_level> 

  <level1> 0 </level1> 

  <level2> 2 </level2> 

<time_range_ind> 0 </time_range_ind> 

<base_date><model>base_date:format=xsd,model_name=cosmo7</model></base_date> 

<!-- equivalent to dt_validity and run --> 

<id_method> 09 </id_method> 

</fcs_element> 

 <product><!-- this tag can be multiple, one for each station point--> 

<point_reference> 
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   <wmo_block> (wmo block number) </wmo_block> 

   <wmo_station>(wmo station number)</wmo_station> 

<lat><model>grid_point_latitude:location_name=06610, 

location_group=wmo,model_name=cosmo-7</model></lat> 

<lon><model>grid_point_longitude:location_name=06610, 

location_group=wmo,model_name=cosmo-7</model></lon> 

<height><model>grid_point_height:location_name=06610, 

location_group=wmo,model_name=cosmo-7</model></height> 

                        <lsm><model>field:tag=FR_LAND,level=-1, level_class=slev, 

model_name=cosmo-7, location_group=wmo,location_name=06610, lead_time_idx=1 </model> 

</lsm> 

</point_reference> 

<grib _data> <!-- this tag can be multiple, one for each validation date and perturbation number--> 

 

<grib_value><model>field:tag=T_2M,level=2,level_class=z,model_name=cosmo-7, 

location_group=wmo,location_name=06610,lead_time_idx=2</model></grib_value> 

<validation_date><model>validation_date:lead_time_idx=2,format=xsd, 

model_name=cosmo-7 </model>  

</validation_date> 

<perturbation_number><model>ensemble_member_id:model_name=cosmo-7 </model> 

</perturbation_number> 

<n_fcs_ensemble> <model>ensemble_size:model_name=cosmo-7 </model> 

</n_fcs_ensemble> 

</grib_data> 

 </product> 

 </list_element> 

</fcs> 

 

 Example XML template with new keys for the dynamic generation of model and parameter 

information with fieldextra (choice of key names only preliminary): 

 

<fcs gribEditionNumber=1> <!--related to one model on a specific grid --> 

<model> <!--model information--> 

 <cd_model_process><model>generating_process_id:model_name=cosmo-

7</model></cd_model_process> 

<origination_centre><model>originating_center:model_name=cosmo-7</model></origination_centre> 
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<n_fcs_ensemble> <model>ensemble_size:model_name=cosmo-7 </model> </n_fcs_ensemble> 

<missing_value_code><model>missing_value_code :model_name=cosmo-

7</model></missing_value_code> 

</model> 

<list_element><!-- this tag can be multiple, one for each parameter field of the model--> 

<fcs_element> 

  <code_table><model> table_number :tag=T_2M</model></code_table> 

  <cd_parameter><model>parameter_id:tag=T_2M </model></cd_parameter> 

  <id_level><model>level_type:tag=T_2M</model> </id_level> 

  <level1> <model>level_value1:tag=T_2M</model></level1> 

  <level2> <model>level_value2:tag=T_2M</model> </level2> 

<time_range_ind><model>time_range_indicator:tag=T_2M</model></time_range_ind> 

<base_date><model>base_date:format=xsd,model_name=cosmo7</model></base_date> 

<!-- equivalent to dt_validity and run --> 

<id_method> 09 </id_method> 

</fcs_element> 

 <product><!-- this tag can be multiple, one for each station point--> 

<point_reference> 

   <wmo_block> (wmo block number) </wmo_block> 

   <wmo_station>(wmo station number)</wmo_station> 

<lat><model>grid_point_latitude:location_name=06610, 

location_group=wmo,model_name=cosmo-7</model></lat> 

<lon><model>grid_point_longitude:location_name=06610, 

location_group=wmo,model_name=cosmo-7</model></lon> 

<height><model>grid_point_height:location_name=06610, 

location_group=wmo,model_name=cosmo-7</model></height> 

                        <lsm><model>field:tag=FR_LAND,level=-1, level_class=slev, 

model_name=cosmo-7, location_group=wmo,location_name=06610, lead_time_idx=1 </model> 

</lsm> 

</point_reference> 

<grib _data> <!-- this tag can be multiple, one for each validation date and perturbation number--> 

 

<grib_value><model>field:tag=T_2M,level=2,level_class=z,model_name=cosmo-7, 

location_group=wmo,location_name=06610,lead_time_idx=2</model></grib_value> 

<validation_date><model>validation_date:lead_time_idx=2,format=xsd, 
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model_name=cosmo-7 </model>  

</validation_date> 

<perturbation_number><model>ensemble_member_id:model_name=cosmo-7 </model> 

</perturbation_number> 

<n_fcs_ensemble> <model>ensemble_size:model_name=cosmo-7 </model> 

</n_fcs_ensemble> 

</grib_data> 

 </product> 

 </list_element> 

</fcs> 
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 Example of a T2M of COSMO-7 forecast model connected to Pratica di mare WMO Station: 

<fcs gribEditionNumber=1> <!--related to one model on a specific grid --> 

<model_info> <!--model information--> 

 <cd_model_process>107 </cd_model_process> 

<origination_centre> 215 </origination_centre> 

<n_fcs_ensemble> -9.E9 </n_fcs_ensemble> 

<missing_value_code>-9.E9</missing_value_code> 

</model_info> 

<list_element><!-- this tag can be multiple, one for each parameter field of the model--> 

<fcs_element> 

  <code_table> 2 </code_table> 

  <cd_parameter> 11 </cd_parameter> 

  <id_level> 105 </id_level> 

  <level1> 0 </level1> 

  <level2> 2 </level2> 

<time_range_ind> 0 </time_range_ind> 

<base_date>2014-05-19T12:00:00+00:00</base_date> 

<!-- equivalent to dt_validity and run --> 

<id_method> 09 </id_method> 

</fcs_element> 

 <product><!-- this tag can be multiple, one for each station point--> 

<point_reference> 

   <wmo_block> 16 </wmo_block> 

   <wmo_station>245 <wmo_station> 

<lat>48</lat> 

<lon>12</lon> 

<height >18</height> 

                        <lsm>1</lsm> 

</point_reference> 

<grib _data> <!-- this tag can be multiple, one for each validation date and perturbation number--> 

<grib_value>295.30<grib_value> 

 <validation_date>2014-05-19T13:00:00+00:00</validation_date> 

<perturbation_number>-9.E9 </perturbation_number></grib_data> 
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 </product> 

 </list_element> 

</fcs> 

APPRENDIX III CODE FOR CONFIDENCE INTERVALS   

MAE_CI_low  

require(verification) 

booter <- function(d, i) { 

A<-verify(d[i, "surface_value"], d[i,"grib_value"],frcst.type="cont", obs.type="cont") 

return(c(A$MAE)) 

} 

df=data.frame(fcs,obs) 

booted <- boot(df, booter, 300);score_ci <- boot.ci(booted,conf=c(0.99),type=c("perc"),index=1);low_ci <- 

score_ci[[4]][4];index <- low_ci  

 

MAE_CI_high  

require(verification) 

booter <- function(d, i) { 

A<-verify(d[i, "surface_value"], d[i,"grib_value"],frcst.type="cont", obs.type="cont") 

return(c(A$MAE)) 

} 

df=data.frame(fcs,obs) 

booted <- boot(df, booter, 300);score_ci <- boot.ci(booted,conf=c(0.99),type=c("perc"),index=1);high_ci <- 

score_ci[[4]][5];index <- high_ci 

 

RMSE_CI_low  

require(verification) 

booter <- function(d, i) { 

A<-verify(d[i, "surface_value"], d[i,"grib_value"],frcst.type="cont", obs.type="cont") 

return(c(sqrt(A$MSE))) 

} 

df=data.frame(fcs,obs) 

booted <- boot(df, booter, 300);score_ci <- boot.ci(booted,conf=c(0.99),type=c("perc"),index=1);low_ci <- 

score_ci[[4]][4];index <- low_ci 
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RMSE_CI_high  

require(verification) 

booter <- function(d, i) { 

A<-verify(d[i, "surface_value"], d[i,"grib_value"],frcst.type="cont", obs.type="cont") 

return(c(sqrt(A$MSE))) 

} 

df=data.frame(fcs,obs) 

booted <- boot(df, booter, 300);score_ci <- boot.ci(booted,conf=c(0.99),type=c("perc"),index=1);high_ci <- 

score_ci[[4]][5];index <- high_ci 

  

MSE_CI_high  

require(verification) 

booter <- function(d, i) { 

A<-verify(d[i, "surface_value"], d[i,"grib_value"],frcst.type="cont", obs.type="cont") 

return(c(A$MSE)) 

} 

df=data.frame(fcs,obs) 

booted <- boot(df, booter, 300);score_ci <- boot.ci(booted,conf=c(0.99),type=c("perc"),index=1);high_ci <- 

score_ci[[4]][5];index <- high_ci 

 

MSE_CI_low  

require(verification) 

booter <- function(d, i) { 

A<-verify(d[i, "surface_value"], d[i,"grib_value"],frcst.type="cont", obs.type="cont") 

return(c(A$MSE)) 

} 

df=data.frame(fcs,obs) 

booted <- boot(df, booter, 300);score_ci <- boot.ci(booted,conf=c(0.99),type=c("perc"),index=1);low_ci <- 

score_ci[[4]][4];index <- low_ci 

 

ME_CI_high  

require(verification)  

booter <- function(d, i) { A<-verify(d[i, "surface_value"], d[i,"grib_value"],frcst.type="cont", obs.type="cont") 

return(c(A$ME)) } df=data.frame(fcs,obs) booted <- boot(df, booter, 300);score_ci <- 

boot.ci(booted,conf=c(0.99),type=c("perc"),index=1);index <- score_ci[[4]][5]  
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ME_CI_low  

require(verification)  

booter <- function(d, i) { A<-verify(d[i, "surface_value"], d[i,"grib_value"],frcst.type="cont", obs.type="cont") 

return(c(A$ME)) } df=data.frame(fcs,obs) booted <- boot(df, booter, 300);score_ci <- 

boot.ci(booted,conf=c(0.99),type=c("perc"),index=1);low_ci <- score_ci[[4]][4];index <- low_ci  

 

ETS_CI_low  

require(verification) 

obs <- c(a,b,c,d) 

A<- verify(obs, pred = NULL, frcst.type = "binary", obs.type = "binary") 

B=qnorm(0.01/2)# For 99% CI low 

index <- A$ETS+B*A$ETS.se  

 

PAG_CI_low  

if((a+b)>0){ 

P <-a/(a+b) 

Z=qnorm(0.01/2)# 99%CI 

N=a+b+c+d 

A=(P*(1-P)+Z^2/(4*N))/N 

index <- (P+Z^2/(2*N)+Z*sqrt(A))/(1+Z^2/N)}else{index<-9999}  

 

ETS_CI_high  

require(verification) 

obs <- c(a,b,c,d) 

A<- verify(obs, pred = NULL, frcst.type = "binary", obs.type = "binary") 

B=qnorm(1-0.01/2)# For 99% CI high 

index <- A$ETS+B*A$ETS.se 2 2 NULL 1 

 

EDS_CI_high  

require(verification) 

obs <- c(a,b,c,d) 

A<- verify(obs, pred = NULL, frcst.type = "binary", obs.type = "binary") 

B=qnorm(1-0.01/2)# For 99% CI high 
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index <- A$EDS+B*A$EDS.se  

 

EDS_CI_low  

require(verification) 

obs <- c(a,b,c,d) 

A<- verify(obs, pred = NULL, frcst.type = "binary", obs.type = "binary") 

B=qnorm(0.01/2)# For 99% CI low 

index <- A$EDS+B*A$EDS.se   

 

F_CI_high  

require(verification) 

obs <- c(a,b,c,d) 

A<- verify(obs, pred = NULL, frcst.type = "binary", obs.type = "binary") 

B=qnorm(1-0.01/2)# For 99% CI high 

index <- A$F+B*A$F.se   

 

F_CI_low  

require(verification) 

obs <- c(a,b,c,d) 

A<- verify(obs, pred = NULL, frcst.type = "binary", obs.type = "binary") 

B=qnorm(0.01/2)# For 99% CI low 

index <- A$F+B*A$F.se   

 

FAR_CI_high  

require(verification) 

obs <- c(a,b,c,d) 

A<- verify(obs, pred = NULL, frcst.type = "binary", obs.type = "binary") 

B=qnorm(1-0.01/2)# For 99% CI high 

index <- A$FAR+B*A$FAR.se  

 

FAR_CI_low  

require(verification) 

obs <- c(a,b,c,d) 
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A<- verify(obs, pred = NULL, frcst.type = "binary", obs.type = "binary") 

B=qnorm(0.01/2)# For 99% CI low 

index <- A$FAR+B*A$FAR.se  

 

HSS_CI_high  

require(verification) 

obs <- c(a,b,c,d) 

A<- verify(obs, pred = NULL, frcst.type = "binary", obs.type = "binary") 

B=qnorm(1-0.01/2)# For 99% CI high 

index <- A$HSS+B*A$HSS.se 

 

HSS_CI_low  

require(verification) 

obs <- c(a,b,c,d) 

A<- verify(obs, pred = NULL, frcst.type = "binary", obs.type = "binary") 

B=qnorm(0.01/2)# For 99% CI low 

index <- A$HSS+B*A$HSS.se  

 

KSS_CI_high  

require(verification) 

obs <- c(a,b,c,d) 

A<- verify(obs, pred = NULL, frcst.type = "binary", obs.type = "binary") 

B=qnorm(1-0.01/2)# For 99% CI high 

index <- A$KSS+B*A$KSS.se  

 

KSS_CI_low  

require(verification) 

obs <- c(a,b,c,d) 

A<- verify(obs, pred = NULL, frcst.type = "binary", obs.type = "binary") 

B=qnorm(0.01/2)# For 99% CI low 

index <- A$KSS+B*A$KSS.se 

 

ORSS_CI_high  
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require(verification) 

obs <- c(a,b,c,d) 

A<- verify(obs, pred = NULL, frcst.type = "binary", obs.type = "binary") 

B=qnorm(1-0.01/2)# For 99% CI high 

index <- A$ORSS+B*A$ORSS.se  

 

ORSS_CI_low  

require(verification) 

obs <- c(a,b,c,d) 

A<- verify(obs, pred = NULL, frcst.type = "binary", obs.type = "binary") 

B=qnorm(0.01/2)# For 99% CI low 

index <- A$ORSS+B*A$ORSS.se  

 

POD_CI_high  

require(verification) 

obs <- c(a,b,c,d) 

A<- verify(obs, pred = NULL, frcst.type = "binary", obs.type = "binary") 

B=qnorm(1-0.01/2)# For 99% CI high 

index <- A$POD+B*A$POD.se  

 

POD_CI_low  

require(verification) 

obs <- c(a,b,c,d) 

A<- verify(obs, pred = NULL, frcst.type = "binary", obs.type = "binary") 

B=qnorm(0.01/2)# For 99% CI low 

index <- A$POD+B*A$POD.se  

 

PC_CI_high  

require(verification) 

obs <- c(a,b,c,d) 

A<- verify(obs, pred = NULL, frcst.type = "binary", obs.type = "binary") 

B=qnorm(1-0.01/2)# For 99% CI high 

index <- A$PC+B*A$PC.se  
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TS_CI_high  

require(verification) 

obs <- c(a,b,c,d) 

A<- verify(obs, pred = NULL, frcst.type = "binary", obs.type = "binary") 

B=qnorm(1-0.01/2)# For 99% CI high 

index <- A$TS+B*A$TS.se  

 

TS_CI_low  

require(verification) 

obs <- c(a,b,c,d) 

A<- verify(obs, pred = NULL, frcst.type = "binary", obs.type = "binary") 

B=qnorm(0.01/2)# For 99% CI low 

index <- A$TS+B*A$TS.se  

 

PC_CI_low  

require(verification) 

obs <- c(a,b,c,d) 

A<- verify(obs, pred = NULL, frcst.type = "binary", obs.type = "binary") 

B=qnorm(0.01/2)# For 99% CI low 

index <- A$PC+B*A$PC.se  

 

PAG_CI_high  

if((a+b)>0){ 

P <-a/(a+b) 

Z=qnorm(0.01/2)# 99%CI 

N=a+b+c+d 

A=(P*(1-P)+Z^2/(4*N))/N 

index <- (P+Z^2/(2*N)-Z*sqrt(A))/(1+Z^2/N)}else{index<-9999}  

 

FBI_high  

CT <- matrix(c(a,c,b,d),ncol=2) # a-c-b-d order! 

C <- table.stats.boot(CT, R=100,alpha=0.01) 
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index <- C[[5]]  

 

FBI_low  

CT <- matrix(c(a,c,b,d),ncol=2) # a-c-b-d order! 

C <- table.stats.boot(CT, R=100,alpha=0.01) 

index <- C[[6]]  

 

ME_wind_CI_high  

require(verification) 

booter <- function(d, i) {  

A<-mean(d[i,"wind_d"]) 

return(c(A)) }  

df=data.frame(wind_d) 

names(df)<-c("wind_d")  

booted <- boot(df, booter, 300) 

score_ci <- boot.ci(booted,conf=c(0.99),type=c("perc"),index=1);index <- score_ci[[4]][5]  

 

ME_wind_CI_low  

require(verification) 

booter <- function(d, i) {  

A<-mean(d[i,"wind_d"]) 

return(c(A)) }  

df=data.frame(wind_d) 

names(df)<-c("wind_d")  

booted <- boot(df, booter, 300) 

score_ci <- boot.ci(booted,conf=c(0.99),type=c("perc"),index=1);index <- score_ci[[4]][4]  

 

BRIER_CI_high  

require(verification)  

booter <- function(d, i) { A<-brier(d[i, "Obs"], d[i,"Prob"],bins=FALSE) 

return(c(A$bs, A$bs.reliability, A$bs.resolution, A$bs.uncert, A$ss))  

}  

df=data.frame(Obs, Prob) 
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names(df)<-c("Obs","Prob")  

booted <- boot(df, booter, 300);bs_ci <- boot.ci(booted,conf=c(0.99),type=c("perc"),index=1);index <- bs_ci[[4]][5]

  

 

COR_CI_high  

require(verification) 

booter <- function(d, i) {  

A<-cor(d[i,"grib_value"], d[i,"surface_value"]) 

return(c(A))  

}  

df=data.frame(fcs,obs) 

booted <- boot(df, booter, 300) 

score_ci <- boot.ci(booted,conf=c(0.99),type=c("perc"),index=1);index <- score_ci[[4]][5]  

 

COR_CI_low  

require(verification) 

booter <- function(d, i) {  

A<-cor(d[i,"grib_value"], d[i,"surface_value"]) 

return(c(A))  

}  

df=data.frame(fcs,obs) 

booted <- boot(df, booter, 300) 

score_ci <- boot.ci(booted,conf=c(0.99),type=c("perc"),index=1);index <- score_ci[[4]][4]  

 

MAE_wind_CI_high  

require(verification) 

booter <- function(d, i) {  

A<-mean(abs(d[i,"wind_d"])) 

return(c(A)) }  

df=data.frame(wind_d) 

names(df)<-c("wind_d")  

booted <- boot(df, booter, 300) 

score_ci <- boot.ci(booted,conf=c(0.99),type=c("perc"),index=1);index <- score_ci[[4]][5]  
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MAE_wind_CI_low  

require(verification) 

booter <- function(d, i) {  

A<-mean(abs(d[i,"wind_d"])) 

return(c(A)) }  

df=data.frame(wind_d) 

names(df)<-c("wind_d")  

booted <- boot(df, booter, 300) 

score_ci <- boot.ci(booted,conf=c(0.99),type=c("perc"),index=1);index <- score_ci[[4]][4]  

 

BRIER_CI_low  

require(verification)  

booter <- function(d, i) { A<-brier(d[i, "Obs"], d[i,"Prob"],bins=FALSE) 

return( c(A$bs, A$bs.reliability, A$bs.resolution, A$bs.uncert, A$ss)) 

}  

df=data.frame(Obs, Prob) 

names(df)<-c("Obs","Prob")  

booted <- boot(df, booter, 300);bs_ci <- boot.ci(booted,conf=c(0.99),type=c("perc"),index=1);index <- bs_ci[[4]][4]

  

BRIER_reliability_CI_high  

require(verification)  

booter <- function(d, i) { A<-brier(d[i, "Obs"], d[i,"Prob"],bins=FALSE) 

return(c(A$bs, A$bs.reliability, A$bs.resolution, A$bs.uncert, A$ss))  

}  

df=data.frame(Obs, Prob) 

names(df)<-c("Obs","Prob")  

booted <- boot(df, booter, 300);bs.reliability_ci <- boot.ci(booted,conf=c(0.99),type=c("perc"),index=2);index <- 

bs.reliability_ci[[4]][5]  

 

BRIER_reliability_CI_low  

require(verification)  

booter <- function(d, i) { A<-brier(d[i, "Obs"], d[i,"Prob"],bins=FALSE) 

return(c(A$bs, A$bs.reliability, A$bs.resolution, A$bs.uncert, A$ss))  

}  
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df=data.frame(Obs, Prob) 

names(df)<-c("Obs","Prob")  

booted <- boot(df, booter, 300);bs.reliability_ci <- boot.ci(booted,conf=c(0.99),type=c("perc"),index=2);index <- 

bs.reliability_ci[[4]][4]  

 

BRIER_resolution_CI_high  

require(verification)  

booter <- function(d, i) { A<-brier(d[i, "Obs"], d[i,"Prob"],bins=FALSE) 

return(c(A$bs, A$bs.reliability, A$bs.resolution, A$bs.uncert, A$ss))  

}  

df=data.frame(Obs, Prob) 

names(df)<-c("Obs","Prob")  

booted <- boot(df, booter, 300);bs.resolution_ci <- boot.ci(booted,conf=c(0.99),type=c("perc"),index=3);index <- 

bs.resolution_ci[[4]][5]  

 

BRIER_resolution_CI_low 

require(verification)  

booter <- function(d, i) { A<-brier(d[i, "Obs"], d[i,"Prob"],bins=FALSE) 

return(c(A$bs, A$bs.reliability, A$bs.resolution, A$bs.uncert, A$ss))  

}  

df=data.frame(Obs, Prob) 

names(df)<-c("Obs","Prob")  

booted <- boot(df, booter, 300);bs.resolution_ci <- boot.ci(booted,conf=c(0.99),type=c("perc"),index=3);index <- 

bs.resolution_ci[[4]][4]  

 

BRIER_uncert_CI_high 

require(verification)  

booter <- function(d, i) { A<-brier(d[i, "Obs"], d[i,"Prob"],bins=FALSE) 

return(c(A$bs, A$bs.reliability, A$bs.resolution, A$bs.uncert, A$ss))  

}  

df=data.frame(Obs, Prob) 

names(df)<-c("Obs","Prob")  

booted <- boot(df, booter, 300);bs.uncert_ci <- boot.ci(booted,conf=c(0.99),type=c("perc"),index=4);index <- 

bs.uncert_ci[[4]][5]  
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BRIER_uncert_CI_low 

require(verification)  

booter <- function(d, i) { A<-brier(d[i, "Obs"], d[i,"Prob"],bins=FALSE) 

return(c(A$bs, A$bs.reliability, A$bs.resolution, A$bs.uncert, A$ss))  

}  

df=data.frame(Obs, Prob) 

names(df)<-c("Obs","Prob")  

booted <- boot(df, booter, 300);bs.uncert_ci <- boot.ci(booted,conf=c(0.99),type=c("perc"),index=4);index <- 

bs.uncert_ci[[4]][4] 

 

RMSE_wind_CI_high 

require(verification) 

booter <- function(d, i) {  

A<-sqrt(mean((d[i,"wind_d"])^2)) 

return(c(A)) }  

df=data.frame(wind_d) 

names(df)<-c("wind_d")  

booted <- boot(df, booter, 300) 

score_ci <- boot.ci(booted,conf=c(0.99),type=c("perc"),index=1);index <- score_ci[[4]][5]   

 

RMSE_wind_CI_low 

require(verification) 

booter <- function(d, i) {  

A<-sqrt(mean((d[i,"wind_d"])^2)) 

return(c(A)) }  

df=data.frame(wind_d) 

names(df)<-c("wind_d")  

booted <- boot(df, booter, 300) 

score_ci <- boot.ci(booted,conf=c(0.99),type=c("perc"),index=1);index <- score_ci[[4]][4]   

 

BRIER_skill_CI_low 

require(verification)  

booter <- function(d, i) { A<-brier(d[i, "Obs"], d[i,"Prob"],bins=FALSE) 

return(c(A$bs, A$bs.reliability, A$bs.resolution, A$bs.uncert, A$ss))  
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}  

df=data.frame(Obs, Prob) 

names(df)<-c("Obs","Prob")  

booted <- boot(df, booter, 300);bs.ss_ci <- boot.ci(booted,conf=c(0.99),type=c("perc"),index=5);index <- 

bs.ss_ci[[4]][4]  

 

BRIER_skill_CI_high 

require(verification)  

booter <- function(d, i) { A<-brier(d[i, "Obs"], d[i,"Prob"],bins=FALSE) 

return(c(A$bs, A$bs.reliability, A$bs.resolution, A$bs.uncert, A$ss))  

}  

df=data.frame(Obs, Prob) 

names(df)<-c("Obs","Prob")  

booted <- boot(df, booter, 300);bs.ss_ci <- boot.ci(booted,conf=c(0.99),type=c("perc"),index=5);index <- 

bs.ss_ci[[4]][5]  

 

SD_CI_high 

require(verification) 

booter <- function(d, i) {  

A<-sd(d[i,"grib_value"]-d[i,"surface_value"]) 

return(c(A))  

}  

df=data.frame(fcs,obs) 

booted <- boot(df, booter, 300) 

score_ci <- boot.ci(booted,conf=c(0.99),type=c("perc"),index=1);index <- score_ci[[4]][5]   

 

SD_CI_low 

require(verification) 

booter <- function(d, i) {  

A<-sd(d[i,"grib_value"]- d[i,"surface_value"]) 

return(c(A))  

}  

df=data.frame(fcs,obs) 

booted <- boot(df, booter, 300) 
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score_ci <- boot.ci(booted,conf=c(0.99),type=c("perc"),index=1);index <- score_ci[[4]][4]  

 

Skill MSE - RV_CI_high 

require(verification) 

booter <- function(d, i) {  

A<- 1-(mean((d[i,"fcs"]-d[i,"obs"])^2)/(mean((persistence)^2))) 

return(c(A))  

}  

df=data.frame(fcs,obs) 

names(df)<-c("fcs","obs")  

booted <- boot(df, booter, 300) 

score_ci <- boot.ci(booted,conf=c(0.99),type=c("perc"),index=1);index <- score_ci[[4]][5]   

 

SKILL MSE - RV_CI_low 

require(verification) 

booter <- function(d, i) {  

A<- 1-(mean((d[i,"fcs"]-d[i,"obs"])^2)/(mean((persistence)^2))) 

return(c(A))  

}  

df=data.frame(fcs,obs) 

names(df)<-c("fcs","obs")  

booted <- boot(df, booter, 300) 

score_ci <- boot.ci(booted,conf=c(0.99),type=c("perc"),index=1);index <- score_ci[[4]][4]   

 

MSE_wind_CI_high 

require(verification) 

booter <- function(d, i) {  

A<-mean((d[i,"wind_d"])^2) 

return(c(A)) }  

df=data.frame(wind_d) 

names(df)<-c("wind_d")  

booted <- boot(df, booter, 300) 

score_ci <- boot.ci(booted,conf=c(0.99),type=c("perc"),index=1);index <- score_ci[[4]][5]   
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MSE_wind_CI_low 

require(verification) 

booter <- function(d, i) {  

A<-mean((d[i,"wind_d"])^2) 

return(c(A)) }  

df=data.frame(wind_d) 

names(df)<-c("wind_d")  

booted <- boot(df, booter, 300) 

score_ci <- boot.ci(booted,conf=c(0.99),type=c("perc"),index=1);index <- score_ci[[4]][4]   

 

Skill RMSVWE_CI_high 

require(verification) 

booter <- function(d, i) {  

A<- 1-(sum(d[i,"u_d"]^2+d[i,"v_d"]^2)/(sum(persistence_u^2+persistence_v^2))) 

return(c(A))  

}  

df=data.frame(u_d,v_d) 

names(df)<-c("u_d","v_d")  

booted <- boot(df, booter, 300) 

score_ci <- boot.ci(booted,conf=c(0.99),type=c("perc"),index=1);index <- score_ci[[4]][5]   

 

Skill RMSVWE_CI_low 

require(verification) 

booter <- function(d, i) {  

A<- 1-(sum(d[i,"u_d"]^2+d[i,"v_d"]^2)/(sum(persistence_u^2+persistence_v^2))) 

return(c(A))  

}  

df=data.frame(u_d,v_d) 

names(df)<-c("u_d","v_d")  

booted <- boot(df, booter, 300) 

score_ci <- boot.ci(booted,conf=c(0.99),type=c("perc"),index=1);index <- score_ci[[4]][4]  
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